(For Private circulation only)

Syllabus of
Executive Postgraduate Programme
In

Management

Office of the Coordinator
Executive Postgraduate Programme

XLRI Jamshedpur
June 2005




[ _I

CONTENTS
Page
Preface (vii)
Programme Design and Requirements (ix)
I ECONOMICS
Core COURSES
1. Macroeconomic Policy & Analysis 1
2. Managerial Economics 2
ELECTIVES
3. Economic Indicators: Database & Estimation 3
4. Economics of Human Resources 4
5. Entrepreneurship and New Ventures © 6
6. Industrial Economics & Competitive Strategies 7
7. International Business Economics @ 8
8. Managing Private-Public Partnerships @ 9
. Money Banking & Finance 10
Il. FINANCE
Core COURSES
1. Basic Financial Accounting 12
2. Cost And Management Accounting 13
3. Financial Management - | 13
4. Financial Management - Il 15
ELECTIVES
5 Advanced Management Accounting 16
6. Business Analysis & Valuation (Half-credit course) 17
7. Capital Expenditure Planning And Control 18
8 Commercial Banking 19
9. Corporate Taxation 20
10. Financial Markets 21
11. Financial Modeling Using Excel 23
12. Fixed Income Securities 25
13. International Business Economics © 26

O Offered as an elective in Strategic Management area also.
® Offered as an elective in Finance area also.
© Offered as an elective in Economics area also.



14. International Financial Management 27
15. Mergers, Acquisition and Corporate Restructuring © 29
16. Options and Futures 29
17. Risk Management and Insurance 31
18. Security Analysis and Portfolio Management 32
19. Value at Risk (Half-credit course) 34

I1l. GENERAL MANAGEMENT
CorE COURSES

1. Business Law 35
2. Business Research Methods 36
3. Managerial Communication 38
4. Managerial Ethics 39
ELECTIVES

5. Art of Public Speaking 41
6. Corporate Image Building 42
7. Emotional Intelligence and Managerial Effectiveness 42
8. Marketing Law & 43
9. Neuro Linguistic Programming 46

IV. HUMAN RESOURCE MANAGEMENT
CorE COURSES

1. Personnel Management & Industrial Relation 47
ELECTIVES

2. Labour Law Applications 49
3. Managerial Counselling 50
4. Organisational Change and Development (OC & D) 51
5. Performance Management 52
6. Recruitment & Selection 54
7. Strategic HRM @ 58
8. Training & Development 59

V. INFORMATION SYSTEMS
Core COURSES
1. Business Computing 61
2. Management Information Systems 62

O Offered as an elective in Strategic Management area also.
® Offered as an elective in Marketing area also.

|_
S
.



ELECTIVES

3 Business and Data Communications Networks 63
4 Business Modeling Through System Dynamics 64
5. Cyber Law & I PR 65
6. Data Structures 67
7 Data Warehousing and Data Mining 68
8 DBMS with Oracle 69
9. Decision Support Systems 71
10. e-Business © 72
11. Enterprise Resource Planning © 73
12. Human Resource Information Systems 75
13. Information Security and Risk Management 76
14. 1. S. Strategy 78
15. Object-Oriented Programming 79
16. Software Project Management 81

VI. MARKETING
Core CoOURSES

1. Marketing - | 85
2. Marketing - Il 86
ELECTIVES

3 Business-to-Business Marketing 87
4 Competition and Globalization @ 88
5. Consumer Behaviour 88
6. Integrated Marketing Communications 89
7 International Marketing 90
8 Marketing Decision Models 91
o. Marketing Fair 92
10. Marketing in Practice 92
11. Marketing Law © 93
12. Marketing Research 96
13. Product and Brand Management 97
14. Retail Management 98
15. Rural Marketing 99

O Offered as an elective in Production & Operations Management area also.
® Offered as an elective in Strategic Management area also.
© Offered as an elective in General Management area also.



16. Sales and Distribution Management 100
17. Services Marketing 101
18. Strategic Marketing © 102

VIl. ORGANIZATIONAL BEHAVIOUR
CorE COURSES

1. OB-I: Individual and Group Behaviour in Organization 103
2. OB-II: Organizational Structure, Design and Change 103
ELECTIVES

3 Assertiveness Training 104
4 Building Learning Organizations © 105
5. Consulting to Management 106
6. Cross-Cultural Management 107
7 Designing Organizations for Uncertain Environment © 108
8 Impression Management 109
9 Indian Philosophy and Leadership Excellence 110
10. Leadership, Influence and Power 111
11. Management of Creativity 112
12. Management of Relationships 113
13. Personal Effectiveness and Leadership 113
14. Personal Growth Lab 115
15. Stress Management 116
16. Transactional Analysis 117

VIIl. PRODUCTION & OPERATIONS MANAGEMENT

CorE COURSES

1 Operations Research 118
2. Production Management - | 119
3. Production Management - Il 120
4 Quantitative Techniques - | 120
5 Quantitative Techniques - 11 122
ELECTIVES

6. Advanced Inventory Control 123
7. Advanced Operations Research 123

O Offered as an elective in Strategic Management area also.

|_
©
.



8. e-Business © 124
9. Enterprise Resource Planning @ 125
10. Logistics and Supply Chain Management 126
11. Materials Management 127
12. Production Planning and Control 128
13. Project Management 129
14. Technology Management @ 130
15. Total Quality Management 132

IX. STRATEGIC MANAGEMENT
Core CoOURSES

1. Strategic Management 133
ELECTIVES

2. Building Learning Organizations © 134
3. Competition and Globalization @ 134
4. Designing Organizations for Uncertain Environment © 135
5. Entrepreneurship and New Ventures © 136
6. International Management 137
7. Managing Private-Public Partnerships © 139
8. Mergers, Acquisition and Corporate Restructuring @ 140
. Resource Based Strategy 141
10. Strategic HRM @ 142
11  Strategic Marketing @ 143
12. Strategies for Managing International Health Systems 144
13. Strategies of Co-operation 145
14. Technology Management © 146

Offered as an elective in Information Systems area also.

Offered as an elective in Strategic Management area also.

Offered as an elective in Organizational Behaviour area also.

Offered as an elective in Marketing area also.

Offered as an elective in Economics area also.

Offered as an elective in Finance area also.

Offered as an elective in General Management area also.

Offered as an elective in Production & Operations Management area also.

000000 C



PREFACE

The Syllabus Book presents the broad objectives,
structure, and contents of our Three-Year Executive
Postgraduate Programme in Management. The
syllabus is directional in scope and permits the much
desirable flexibility to keep pace with the ever-growing
body of knowledge, experiments and explorations in
management education including the human side of
enterprise.

This book contains the syllabi of the core and elective
courses the institute has been offering. Electives for
the Executive PG Programme will be offered from among
these courses which would be decided by the respective
areas depending on the need, availability of expertise
and any other reasons which the institute deems fit
for the students to specialise in their areas of choice
within the framework of the rules of the institute with
regard to specialization.

June 2005
XLRI Jamshedpur



PROGRAMME DESIGN AND REQUIREMENTS
EXEC-PGP 2005-08 BATCH

The Executive Postgraduate Programme in Management prepares
executives for career enhancement by leveraging the rigors of a business
management course without interrupting their career. The programme
facilitates learning in theory and practice of different functional areas of
management and to equip the students with an integrated approach to
management function and managerial skills.

The courses are designed to develop - (i) analytical, problem solving and
decision making abilities, (ii) awareness of the socio-economic environment,
and (iii) personality with socially desirable values and attitudes. Towards these
objectives and to suit the contents of each course, a variety of teaching
methodologies, such as case studies, role-play, problem solving exercises, group
discussion, computer simulation games, audio-visuals, are used in the
programme.

The programme consists of 41 three-credit courses (23 core courses and
18 elective courses).

A student can opt for a dissertation in lieu of one full credit elective course
in Term VII. However, only those students who secure a minimum CQPI of 6.00
upto Term V (i.e. in the courses of Term | to V) will be eligible to opt for
dissertation on a topic of their choice in a related field of Management (for
further details, refer Student Manual).

All the core courses and elective courses are of three credits each.

Each full credit course implies a total of 30 contact hours, and is organised
during a Term of 15-20 days with each session of 2 hours. The courses are offered
in the following areas :

Economics

Finance

General Management

Human Resource Management
Information Systems

Marketing

N o O s~ Dde

Organizational Behaviour
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8. Production & Operations Management
9. Strategic Management

The 23 (twenty three) core (compulsory) courses are slated from Term-I to
Term-V. The Term-wise distribution of core courses shall be 4-4-5-5-5. Elective
courses will commence from Term-VI. A student is required to do 18 (eighteen)
elective courses.

Out of the 18 electives in Exec-PGP programme, a student is free to choose
electives from any area. However, to fulfil the requirement of area(s) of
concentration, a student is required to do an equivalent of six full credit electives
in each area, in any of the areas listed below :

1. Economics

2. Finance

3. Human Resource Management

4. Information Systems

5. Marketing

6. Production & Operations Management

7. Strategic Management

A student can opt for a maximum of two areas only. A few elective courses
are common to more than one Area. Therefore, such electives will be counted
in one area only as per the choice of the student.

The elective courses listed in this booklet are the total list of approved
electives for the Programme. The list of electives to be offered in a particular
term would be decided by the respective areas and communicated from time to
time.



I. ECONOMICS

1.1 MACROECONOMIC POLICY & ANALYSIS

Objectives

@ To provide an overview of an exchanged based economy

< To develop an analytical framework to understand the interlinkages among the
crucial macroeconomics variables and various segments of an economy

@ To analyze the implications of changes in policy measures for business and the
economy

Topics
1. Introduction

»  Macroeconomic Analysis and its usefulness
» Macroeconomic Schools of thought

2. National Income Accounting
»  Concepts
»  Assessment of Growth & Development

3. Working of the Economy at Aggregate Level
» Conceptual Framework: Circular Flow of the Economy
» Consumption, Investment Function and Multiplier

4. Inflation and Deflation
» |nflationary & Deflationary Gaps
» Business Cycles

5. Fiscal Policy
» Taxes & Expenditure
» Fiscal imbalance, implications and reforms

6. Monetary Theory and Policy
» Money Demand and Supply
» Financial Structure of the Economy
» |nterlinkages between Real & Financial Sectors

7. External Sector Dynamics
» International Trade, Foreign Capital flows & Balance of Payment
» Exchange Rate and Competitiveness
» |nterlinkages between Domestic & Foreign markets

@



1.2 MANAGERIAL ECONOMICS

Objectives

This course is designed to develop studentsi understanding of how to efficiently
achieve the goals of the firm and to recognize how economic forces affect the
organization. It is expected to enable the students to relate their acquired knowledge
of the firm, and in particular managerial economics, in shaping their own
management practices when they take up managerial responsibilities in the near
future. The basic goal of the course is to improve management decision making in
the context of a firm or organization.

Topics
1. The Firm in the Society
» Demand & Supply Analysis, Production & Cost Analysis

2. Theoretical Foundations: Competitive Environment (Review)
» Theory of the Firm and Market Structure
w Perfect Competition, Monopoly, Monopolistic Competition &
Oligopoly
3. Major Segments of the Global Economy & Economic Models of the Firm

» Private Sector, Public sector, State owned enterprises, Transnational
Enterprises

»  Neoclassical, Industrial, Contractual and PA Models

4. The iOrganizationi of the Firm

S

Internal Organization of the Firm, Part |
» Vertical & Conglomerate Organization

6. Resource Based View of the Firm

7. Basic Game Theory: Concepts and Models

8. Industrial Organization (Market) Approach to Firms
9. Competition Policy

10. Internal Organization of the Firm, Part Il
» Horizontal or Multinational Organization

11. Joint Ventures & State Owned Enterprises

12. Trading Processes: Bargains & Auctions

@



1.3 ECONOMIC INDICATORS : DATABASE AND
ESTIMATION

Objectives

Students would be able to

< |dentify the appropriate and reliable data base for economically relevant
indicators
& Estimate the different economic indicators using the data from various data
sources
< Interpret the economic indicators and analyze the economic structure
< Forecast the future state of the economy and business cycles with the help of
economic indicators using non-econometric methods.
Topics
1. Introduction to Various Data Sources and Accounting Methods
» Data sources and their utility in estimation and forecasting
» Accounting Methods
w National Income Accounts
w  |nput-Output Tables
w Social Account Matrix
w Financial Social Accounting Matrix
2. Major Economic Indicators
» Leading Indicators
ww  Money supply, stock prices, vendor performance, etc.
» Coincident Indicators
ww |ndustrial production, personal income, trade volumes, etc.
» Lagging Indicators
w Commercial loans, short term interest rates, etc.
3. Estimation of and comparison of National Progress
» The origins of GDP and its current uses
» Forecasting issues
» |nternational comparison
=+ Parallel and alternative indicators
4. Prices, Wages and Inflation

» |ntroduction to various CPls and WPIs

&



» Estimation of price indices and inflation
» Benefits from using an alternative measure of inflation
» Forecasting inflation

5. The Labour Market: Employment, Earnings and Productivity Figures
» Definitions of Employment, unemployment, activity & inactivity
» The labour force survey and earning data

6. Short and Long Term Interest Rate
»  What drives the short-term interest rates?
»  Which data releases to watch?
» Determination of long term interest rates
»+ Forecast of interest rates
= Money supply, fiscal deficit and regulatory changes
w Forecasting interest rates from the yield curve

7. Key International Indicators
» Balance of payments: Components and description
» Exchange rates: Rupees relationship with US $, Yen, Pound sterling, etc.
» Estimation of composite exchange rates: REER and NEER

8. Major Indicators and Correlation between Different Markets
» Forecasting business cycles and future state of the economy
» Composite leading indicators and forecasting performance

1.4 ECONOMICS OF HUMAN RESOURCES

Objectives

As there is sea-change in the economic front, the labour market is bound to be
influenced. With the transfer of technology and the increasingly competitive
business environment such transformation is often been quite dramatic.

In this course, which is a branch of applied economics, there will be an attempt
to identify the principal theoretical approaches and to indicate the direction of
empirical research in each area. Theories and examples that are applicable to
free market mechanism will be discussed together with the problems and
limitations of these tools when there exists a sizeable public sector in the
economy.

<,



Topics

1. Human Capital Theory
» The Human Capital Model
» Predictions of Human Capital Approach

2. The Demand for Human Capital
»  Short-run and Long-run Demand
» Elasticities of Demand for Human Capital
»+ The Laws of Derived Demand Limitations

3. The Theory of Individual and Household Labour Supply
» A Life-cycle Approach to Labour Supply
» Labour-Force Participation
» Empirical Aspects of Labour Supply
» Limitations

4. Occupational Choice
» Hedonic Theory of Wages
» Compensating Wage Differentials

5. Uncertainty, Screening and Signalling
» Information in Labour Markets
» The Job Search Model
» Credentials or Screening Devices

6. Investment in Human Capital

7. Mobility of Human Resources
» Turnover and Migration

8. Economic Issues in Compensation
» Fringe Benefits
» Incentive Pay
» |nternal Labour Market and Time Pattern of Compensation

9. Discrimination in Labour Market
10. Human Capital Market in Private and Public Sector

11. Unemployment Rate and Labour Market Flows
» The Economics of Trade Unions

12. The Human Resources Market
» Efficiency and Distribution

<,



1.5 ENTREPRENEURSHIP AND NEW VENTURES

Objectives

The major emphasis of the course will be on creating a learning system through
which management students can acquaint themselves with the special challenges
of starting new ventures and introducing new product and service ideas. This will
involve working together to investigate, understand and internalize the process of
founding a startup. Bootstrap and guerilla tactics to gather resources - the technology,
team, finance and market - to give birth to entrepreneurial businesses will be
discussed.

The course is designed primarily for those who at some point of their career want to
start their own ventures, or run their own family businesses. But it is equally useful
to those who plan to work in or with new ventures either as venture capitalists,
consultants to new firms or in new business development units of larger corporates.

Topics
1. The early career dilemmas of an entrepreneur
» The entrepreneuris role, task and personality
» A typology of entrepreneurs: Defining survival and success
» Entrepreneurship as a style of management
» The entrepreneurial venture and the entrepreneurial organization

2. Choosing a direction

»  Opportunity recognition and entry strategies: New product, Franchising,
Partial momentum, Sponsorship and Acquisition

»  The strategic window of opportunity : scanning , positioning and analysing
» Intellectual Property : Creation and protection

3. Opening the window: gaining commitment
» Gathering the resources you donit have
» The business plan as an entrepreneurial tool
» Financial Projections: how to do them the right way
» Debt, venture capital and other forms of financing
»  Sources of external support

» Developing entrepreneurial marketing: Competencies, networks and
frameworks

4. Closing the window: sustaining competitiveness
» Maintaining competitive advantage
» The changing role of the entrepreneur : mid career dilemmas
» Harvesting Strategies versus Go for Growth

©,



1.6 INDUSTRIAL ECONOMICS & COMPETITIVE
STRATEGIES

Objectives

1. To help gain an understanding of :
i) The structure - conduct - performance relationship in an industry.
ii) The factors influencing these

2. To acquire the knowledge/skill to evolve competitive strategies and thereby
determine the conduct of a firm in the market.

Topics
1. The welfare economics of Market Power
» Measurement and Determinants of Market Power
» Market Power and Pricing
» The determinants of Dead Weight Loss
» Market Power and Public Policy

2. (S-C-P) Structure - Conduct - Performance relationship S-C-P - Empirical
appraisal.

3. Determinants and role of market structures

»  Monopoly

w Dominant Firms

= Durable Goods Monopoly

w Pricing & Price discrimination
»  Oligopoly

w  Pricing

w Game Theory

w  Other Models
» Monopolistic Competition

w Product Differentiation

4. Strategic Behaviour
5. Issues in Anti trust Economics

6. Issues in Regulatory Economics
» Rationale for regulation
» Optimal pricing for Natural Monopoly
»+  Other issues
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7. The legal framework of Antitrust Enforcement
8. Economics of Information
9. International Trade
1.7 INTERNATIONAL BUSINESS ECONOMICS
Objectives

The broad focus of this course will be

@ To understand the important linkages between domestic economy and its
external sector
@ To gain the conceptual clarity of the theoretical aspects of international trade
and finance
& To examine the broad pattern of changes in the international economic policy
@ To examine the business implications of international economic environment
< To identify the basic macroeconomic relationships as they affect the behaviour
of firm
@ To incorporate international issues in designing corporate strategies in a fast
changing environment.
Topics
1. International Monetary Systems
» International Business Environment
» International monetary System
» European Monetary System and Emergence of Euro
2. Developing Countries' Concerns
» Exchange Rate Policy of Developing Economies
» India's Exchange Rate Regimes and Experiences
» Nominal vs Real Exchange Rates, Bilateral vs Effective
» Exchange Rates and the Economy
3. International Financial Flows

» Emergence of International Financial Intermediation
» Recent Changes in the International finance
» Resource Flows to Developing Countries



4. Emerging Market Analysis
» Country Risk Analysis
» Foreign Investment Analysis: Direct and Portfolio
» Currency Convertibility: Current Account and Capital Account
» South Asian Currency Crisis
5. International Trade
» Developments in International Trade Theory
» Trade Policy Instruments and Liberalization
» World Trade Organization

6. Legal Dimension in International Business
1.8 MANAGING PRIVATE-PUBLIC PARTNERSHIPS

Objectives

@ |llustrate the value of partnerships in sectors like infrastructure, health,
education, urban renewal and business development services.

@ List factors critical to successful cooperation, and a suggested approach to
planning, implementing, and operating successful public-private ventures.

@ Discuss representative examples of public-private sector cooperation which have
worked, and of others that have failed, including the reasons why.

< Recall the types of legal, regulatory, financial, procurement, contracting,
management, administrative and public policy issues, which must be taken
into account.

& Relate the relative strengths, weaknesses, advantages and disadvantages of
different forms of cooperation, as viewed from the perspectives of the user
community, a typical government agency and a typical private sector
organization.

@ Recognize and describe the various forms that public-private partnerships can
take.

< Explain the approach to HR planning, financing and public relations required to
ground successful PPP projects.

Topics

1. Rationale and options for PPP

»  Sector wise analysis of PPP leading to a methodology matrix to determine

&,



which PPP option best fits a pilot project or sector. Discuss different types

of PPP options i service / management contracts, joint ventures,
divestiture, licensing, leases and concessions. Familiarize students with
the planning priorities of the government that create windows of
opportunity for the private sector.

Screening PPP Project Opportunities
» Pre feasibility Project Identification and Selection Process

» Cost comparator and value for money models to rank and select highest
quality projects and decide on go or no- go

» Project finance and risk allocation, Planning for PPPs
» Credit enhancement techniques for PPP Project financing

PPP Procurement Strategies
» Selecting the appropriate Procurement Method for PPPs
»  Procurement and Tendering Regulations for PPPs in India

» HR systems of government and civil society : whom to speak to and how
in the bureaucracy

» PPP negotiations skills and techniques and risk mitigation strategies

Regulation, Monitoring and Compliance

» Key elements for an appropriate enabling and regulatory environment
for PPPs

» Simulation : Structuring and regulating a PPP contract

Institutionalizing PPP Processes within public systems and within the private
sector.

1.9 MONEY BANKING AND FINANCE

Objectives

The students should be able to

&

Comprehend the need, definition, functions and economic significance of
financial institutions and markets

Understand the interdependence between financial markets and interest rates

Comprehend the behavioral analysis of interest rates: risk, liquidity and term
structure

Identify the role played by the Central Bank and instruments of credit control



@ Grasp the conduct of monetary policy and its effect on interest rate, credit
availability, prices and inflation rate

Topics
1. An Overview of the Financial System
» Saving and Investment
» Money, Inflation & Interest
» Banking and Non Banking Financial Intermediaries

2. Financial Markets and Instruments
» Money market and Capital Markets
» Financial Instruments: REPO, TBs, Equities, Bonds, Derivatives etc.
» Characteristics of Financial Instruments: Liquidity, Maturity, Safety & Yield

3. Principles of Financial Markets & Interest Rates
» Understanding Interest Rates
»+ Risk and Term Structure of Interest Rates
» |Interdependence of Markets and Interest Rates
» Rational Expectations & Efficient Markets

4. Economics of Banking (Depository) Institutions
» Banking Institutions: Revenues, Costs and Profits
» Basic Issues and Performance of Depository Institutions
»  Asymmetric Information & Banking Regulation

5. Central Banking, Monetary Policy & Regulation
» The RBI as a Central Bank: Structure, Functions and Working
»  Reforms
» The Current Regulatory Structure

6. Essentials of Monetary Theory
» The Classical and Keynesian Theories of Money, Prices and Output
» Rational Expectations and Modern Theories of Money and Income

7. Conduct of Monetary Policy & Interlinkages
»+ QObjectives and Targets of Monetary Policy
» Policy Lags and Intermediate Targets
» Rules Vs. Discretion in Monetary Policy
» Interlinkages
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1. FINANCE

1.1 BASIC FINANCIAL ACCOUNTING

Objectives

< To familiarize the students with financial statements and principles underlying
them and to develop their skills in reading Annual Reports.

@ To acquaint them in brief with accounting mechanics, process and system, but
emphasis is laid on sound concepts and their managerial implications.

@ To lay a foundation for developing their skills in interpreting financial statements.

Topics
1. Understanding Financial Statements (An Overview)
2. Interpreting Financial Statements (An Overview)
3. Accounting Mechanics, Process and System
» |Introducing Book Keeping and Record Maintenance
»  The concept of double entry and fundamental principles
»+  Journal
» Ledger
»+ Trial Balance
» Cash Book
» Subsidiary Books
» Bank Reconciliation Statement
»+ Rectification of Errors
» Final Accounts
»+ Extended Trial Balance to Final Accounts
» Final Accounts from Incomplete Records
Significant Accounting Policies, Accounting Standards
Certain Special Features of Corporate Accounting
Form and Contents of Financial Statements and Interfaces with Companies Act
Creative Accounting and Implications thereof

Analyzing and Interpreting Financial Statements

© © N o g A

Cash Flow and Fund Flow Techniques
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1.2 COST AND MANAGEMENT ACCOUNTING

Objectives

@ To familiarize the students with cost records / statements and principles
underlying them and to develop their skills in understanding and appreciating
cost information.

< To acquaint them in brief with cost and management accounting mechanics,
process and system, but emphasis is laid on sound concepts and their managerial
implications.

& To develop an appreciation about the utility of cost information as a vital input
for management information and decision making process.

Topics

Introduction to Cost and Management Accounting

Treatment of Overheads

Unit Costing (Cost Sheet)

Joint Product, By Products and Contract Costing

Process Costing

Maintenance of Cost Records, Cost Finance Reconciliation

N o o kM w DN

Absorption Costing, Marginal Costing, Cost Volume Profit Analysis and Decision
Making

Relevant Cost and Differential Cost

Budgetary Controls
10. Standard Costing
11. Inventory Management and Cost Audit (An Overview)
12. Activity Based Costing

13. Application of Costing concepts in the Service and Trading Sector

1.3 FINANCIAL MANAGEMENT - |

Objectives
This course aims at,

& Familiarising the students with the finacial environment of business,
especially the financial markets

&,



< |Imbibing knowledge about the decisions and decision variables involved in
building the liability side of balance sheet of the firm

@ Developing the analytical skills by associating the tools and techniques with
the situation

< Developing skills for interpretation business information and application of
financial theory in financing related decisions

Topics
1. Financial Environment of Business (with special emphasis on India)
» General financial environment
» |ntroduction to Financial Markets
Capital Markets
Primary Market

Basics of capital market mechanism,

instruments,
financing and rating institutions, and
legal environment related to this.

ONONON®,

Secondary Market
Basics of stock exchanges and their role,
regulatory framework, and

transactions on stock exchange

ORONG)

Money Markets
Basics of money market mechanism,
instruments,

institutions, and

legal environment related to this.

ONONON®

2. Corporate Financial Objectives and Functions

3. Financial Analysis

» Ratio analysis (liquidity ratios, profitability ratios, turnover ratios,
structural ratios, etc.)

w Comparative balance sheet
w Common size statement analysis
w Trend analysis
w Sickness prediction
» Funds Flow analysis

4. Risk and Return Portfolio Theory



5. Sources of Funds (including regulatory framework)
» Types of securities
» |ssuing the capital in market
»  Pricing of issue
»  Valuation of Stocks and bonds

6. Dividend policy and issue of bonus shares

7. Capital Structure Decision
» Modigliani-Millar proposition | and 11
» Capital structure theories
» |nterface with cost of capital

1.4 FINANCIAL MANAGEMENT - Il

Objectives
This course aims at,
< Familiarising the students with the valuation of firm

< |Imbibing knowledge about the decisions and decision variables involved in
building the asset side of balance sheet of the firm

< Developing the analytical skills by associating the tools and techniques with
the situation

@ Developing skills for interpretation business information and application of
financial theory in corporate investment decisions, with special emphasis on
working capital management.

Topics
1. Valuation of the firm
2. Calculating cost of capital

» Calculating cost of specific funds
» Calculating weighted average cost of capital

3. Corporate Investment Decisions
»+ |ntroduction
» Cash flow projection
» Evaluation techniques

4. Evaluation of lease contracts

&,



5. Corporate Restructuring
» Mergers and acquisitions
w Types of mergers
w Evaluation of merger proposal
=+ Take-over
» Amalgamation
» Leverage buy-out
» Management buy-out

6. Financial Restructuring
»  Share split
»+ Consolidation
» Cancellation of paid up capital
»+  Other mechanisms

7. Corporate Failure and Liquidation

8. Working capital management

» Working capital planning

» Monitoring and control of working capital

» Working capital financing

» Managing the components of working capital
w Cash management
w Receivable management
w |nventory management

1.5 ADVANCED MANAGEMENT ACCOUNTING

Objectives

@ To provide necessary inputs to the students in form of iAdvanced Management
Accountingi techniques. However, emphasis is laid on sound concepts and their
managerial implications.

@ To focus heavily on the practical and strategy aspects of iAdvanced Management
Accounting? which will equip the students to apply their skills and knowledge
effectively in the future while dealing with real life business problems /
situations.

@ To develop an appreciation about the utility and applicability of iAdvanced
Management Accounting Techniquesi as an essential and integral component
of management information for the purpose of the entire financial decision

making process.



@ To enrich the learning process through exposure to real life cases / business
situations and live projects.

Topics

1. Financial Analysis applying advanced management accounting techniques.

2. Accounting Standards and their implications. (AS 14 onwards).

3. A thorough comparative study of US GAAP, UK GAAP and Indian GAAP

4. Creative Accounting and World Wide Accounting Scandals and implications
thereof

5. Critical Evaluation of Sample Annual Reports

6. Accounting for Amalgamation

7. Consolidation

8. Short Term Decision Making and Pricing Decisions applying management

accounting.
9. Strategic Profitability Analysis
10. Working Capital Estimation
11. Advanced Cash Management Techniques

12. Advanced Techniques for Management of Receivables.

1.6 BUSINESS ANALYSIS & VALUATION
(Half-Credit Course)

Objectives

This course will have all the elements that would go into reviewing a potential
investment opportunity. It is not a detailed course in one category, such as financial
accounting, but it ties business strategy analysis, financial analysis, forecasting
analysis, and valuation analysis together. This course takes the path to evaluating
the opportunity to its fullest after one has gone through basics of strategy, finance,
and accounting.

CAREER FOCUS #i It is aimed at students who expect at some point in their careers
to evaluate the performance, prospects, and value of a business.

EDUCATIONAL OBJECTIVES A The objective of the course is to provide hands-on
experience in valuation especially using financial analysis.

@



Topics
1. Valuation Issues from Different Perspective & Business Analysis
2. Different Valuation Methods
» Recasting Financial Statements
»  Applying Statistical Techniques
» Equipment/Asset Valuation Approaches
» Debt Assumption, Cost to Create & Advanced Market Approaches
» Modified & Discretionary Earnings Techniques
» Capitalization of Earnings & Discounted Future Benefits Approaches

3. Valuing Partnerships, ESOPs, Intellectual Property & Minority Interests

4. Corporate Taxes and Valuation, Use and Abuse by Experts

I1.7 CAPITAL EXPENDITURE PLANNING AND CONTROL

Objectives

@ To provide necessary inputs to the students in form of concepts, theories and
financial management techniques related to capital expenditure / investment
decisions.

% To aid the students in developing an integrated approach to capital expenditure
decision-making process primarily emphasizing on sound concepts and their
managerial implications.

@ To focus heavily on the practical and strategy aspects of capital expenditure
decisions which will equip the students to apply their skills and knowledge
effectively in the future while dealing with capital expenditure decisions.

@ To enrich the learning process through exposure to real life cases /7 business
situations and live projects.

Topics

1. The fundamentals of capital budgeting (A recapitulation)

2. The fundamentals of cost of capital & capital structuring (A recapitulation)
3. Market Demand Forecasting Techniques

4. Financial Forecasting (emphasizing on cash flow forecasts)

5

Simple Risk Management Techniques in CAPEX Decision Making Process



6. Leasing
7. Interfaces with relevant Accounting Standards
8. Interfaces with Excise Laws and Companies Act
9. Interfaces with Income Tax Act
10. Project Financing and other miscellaneous topics
11. Sickness Prediction and Distress Restructuring
12. Advanced Risk Management Techniques in CAPEX Decision Making Process
13 Securitization (A practical insight)
11.8 COMMERCIAL BANKING
Objectives
@ Providing an in-depth analysis of the commercial banking in the liberalized
Indian economy
< Familiarizing the students with the regulating framework for banks in India
& Equipping the students with the tools used in interpreting and evaluating
performance, productivity and efficiency of the banking organizations
& Equipping the students with the in depth knowledge of financial management
in the banking organizations
@ Familiarizing the students with the new banking practices and processes
Topics
1. Indian Financial System: An Overview
2. Indian Banking System
» Banking Structure in India
» Evaluation of the Banking System and Future Trends
3. Analysis of the Banking Structure and Performance Measurement

» |nterpreting Bank Balance Sheet & Income Expenditure Statements
» Financial Statement Analysis and Bank Performance Measurement
w CAR, NPA, Liquidity Ratios, Structural Ratios & Profitability Ratios



4. Banking Regulations
» Control of the Banking Sector by the RBI
= CRR, SLR, CRAR and Income Recognition Norms, Provision for NPAs
5. Management of Banking Organization
» Loan Management
» |nvestment Management
» Liguidity Management
»  Profit and Growth Management
»  Asset Liability Management Using traditional GAP & Modern Techniques
6. Mergers & Acquisition, Bancassurance and Universal Banking
»  Opportunity for Strengthening the Banking Organization
7. Financial Innovations and Opportunities for Banks
» Factoring, Securitization and Take Out Finance
8. Technological Innovations and Opportunities for Banks
9. International Banking
»+ Organizational Structure, Activities and Regulation
11.9 CORPORATE TAXATION

Objectives

< The primary objective of this course is to familiarize the students with relevant
provisions of taxation laws (both direct and indirect taxes) stressing on the tax
planning considerations.

@ Providing necessary inputs to the students for handling real life business
problems efficiently using appropriate concepts of taxation laws.

@ To acquaint them with the salient features of taxation laws but emphasis is
laid on sound concepts and their managerial implications focusing on tax
planning.

Topics

1. Introduction to Direct and Indirect Taxes

2. Indirect Taxes

» Central Sales Tax
»  Service Tax
» Excise Duty and CENVAT



3. Income Tax

>+

>+

>+

Objectives

Introduction to Income Tax

Exempted Income, Advance Taxes and TDS
Personal Income Tax (Salaries Only)

Profits and Gains of Business and Profession
Capital Gains

Set Off and Carry Forward of Losses
Deductions from Gross Total Income
Assessment Procedure

Other Miscellaneous Provisions

Tax Planning Considerations

Major changes / Developments as per the last Union Budget

11.10 FINANCIAL MARKETS

The course aims at:

< Familiarising the students with the Indian capital market, its operations,
instruments, regulations etc.

@ Helping students in acquiring analytical skills in the market analysis in the
context of raising medium and long term funds

& Familiarising the students with the operations of secondary market
mechanism

@ Developing an appreciation among the students for the interfaces among
government policies, capital market, investors and firms

Topics

1. Financial Markets

»+

>+

»+

Introduction
Government economic philosophy and financial market
Structure of financial market in India

2. Capital Market

>+

Capital Market Theory
w |ntroduction, Concept, Role, Importance, Evolution in India etc.
w Critical evaluation of the development
w Future trends

@



» Primary Market System and Regulations in India

(=3

(=3

=

Types of firm's interface with investors
Types of scripts

Issue of capital: process, regulations, legalities, pricing of
issue, methods of issue, book-building, road-show,
intermediaries in issue management

Managing shareholder relations

Primary market intermediaries: commercial banks,
development banks, custodians, merchant bankers, issue
managers, rating agencies etc.

» Secondary Market System and Regulations in India

(=3

Stock exchanges in India: History and development and
importance

Listing of scripts

On-line trading

Depositories: Growth, development, regulation, mechanism
OTC Exchange

Stock exchange mechanism: trading, settlement, risk
management, investor grievances, basics of pricing
mechanism, carry forward, Badala, automated lending and
borrowing mechanism

Inside trading, circular trading, price rigging etc.

Players on stock exchange: investors, speculators, market
makers, bulls, bears, stags

Stock exchange regulations

Stock Exchange Board

Stock indices

Role of Flls, MFs and Investment Bankers

» Regulations and Regulatory Agencies (Primarily SEBI)

=

=

3. Other Topics
Bond market in India: government bond market and its interface with
capital market

Debt market in India

Interface between

»+

(=3

=

(=3

For primary markets
For secondary markets

Stock market and bond market
Primary and secondary markets
Capital market and money market

Mutual fund: concept, mechanism, role etc.

@



Objectives

Modeling techniques for accurate financial forecasting are used in many areas of
finance, such as derivatives, valuation, project evaluation, deal structuring, portfolio
management and the like. In the course, the participants will learn the model
building skills required to build powerful models in finance with the help of excel.
There are many features of model building that are common irrespective of the
final model that one intends to build. In the course we will also emphasize on the
different model building skills that one should have irrespective of the final use

11.11

that one is going to make of it.

By the end of the course the participants should be better able to:

Understand the basic and advanced features of excel

Understand how to build models in excel to suit oneis purpose

Building models in different areas of finance including investments, corporate

finance and derivatives

Identifying and controlling the key sensitivities with advanced spreadsheet

Understand how risk can be built into the model to enhance decision making

Understanding the basic features of excel

Introduction to Modeling
Introduction to Excel

Understanding advanced features of excel

Database functions in excel

Creating charts

Using forms and control toolbox

Understanding finance functions present in excel
Creating dynamic models

Sensitivity analysis using Excel

Scenario Manager
Other sensitivity analysis features

-
-
-
-
simulation
-
process
Topics
1.
>+
»+
2.
>+
>+
>+
»+
»+
3.
>+
»+
4,

Simulation using Excel

>+

>+

Different statistical distributions used in simulation

Generating random numbers that follow a particular distribution

@

FINANCIAL MODELING USING EXCEL



» Building models in finance using simulation

5. Excel in Accounting
» Preparing common size statements directly from trial balance
» Forecasting financial statements using excel
»  Analyzing financial statements by using spreadsheet model

6. Excel in Project Appraisal
» Determining Project Viability
» Risk Analysis in project Appraisal
» Simulation in project Appraisal

7. Excel in Valuation
»+ Determination of Value Drivers
» DCF Valuation
» Risk Analysis in Valuation

8. Excel in Portfolio Theory
» Determining efficient portfolio
»  Creating dynamic portfolios
» Portfolio Insurance
» Fixed Income Portfolio Management Using Excel

9. Excel in Derivatives
» Black and Scholes Model in Excel
»  Greeks in Excel
» Real Options Valuation

10. Building a Mega Model

11. Understanding Subroutines and Functions and building simple financial models
using subroutines and functions

» Recording and editing macros
»+  Subroutines and functions

» Decision rules

» Message box and input box

» Debugging

12. Designing advanced financial models using VBA
»  User forms
»  Other advanced Features

»  Actual Model Building



11.12 FIXED INCOME SECURITIES

Objectives

This course is intended to analyze the fixed income securities markets and its
implications for investments. It will analyze the following:

< Market characteristics, instruments, selling techniques of debt secruities
< Pricing and valuation issues of fixed and floating rate instruments

@ Risk and return of fixed income securities and their derivatives

< Bond portfolio management techniques used by institutional investors

< Finally, the interplay of government, corporates and instituational investors
in the debt markets.

Topics
1. Fixed Income Securities Markets : Overview
» Institutional Arrangements
» Market Participants and Instruments
» Investors Perspectives: Risk and Rewards

2. Treasury Securities Auction
» Government Bond Markets
» Auction Mechanisms
» Uniform vs Discriminatory Auction
» Auction and Repo Markets
» Markets Implications of Auctions

3. Bond Mathematics
» Time Value of Money
»+ Price and Yield Conventions
» Bond Valuation

4. Risk ldentification in Bonds
» Duration, Convexity
» Immunization Strategies

5. Yield Curve Analysis
» Par Value, Zero, Spot Curve
» Term Structure of Interest Rates
» Constructing Yield Curve: Bootstrapping

@



6. Corporate Debt Markets
»  Structure, Rating, Spread
» Issuers and Investors Perspectives
=+ Valuation, Convertibles
» Financial Distress, Bankruptcy

~

. Bond Portfoilo Management Strategies

©

Fixed Income Derivative Markets
» FRAs, Swaps, Futures, Options

9. Global Fixed Income Securities Markets: Indexing, Securitisation

11.13 INTERNATIONAL BUSINESS ECONOMICS

Objectives
The broad focus of this course will be

% To understand the important linkages between domestic economy and its
external sector

@ To gain the conceptual clarity of the theoretical aspects of international trade
and finance

@ To examine the broad pattern of changes in the international economic policy
@ To examine the business implications of international economic environment

< To identify the basic macroeconomic relationships as they affect the behaviour
of firm

@ To incorporate international issues in designing corporate strategies in a fast
changing environment.

Topics
1. International Monetary Systems
»+ |nternational Business Environment
» |nternational monetary System
» European Monetary System and Emergence of Euro

2. Developing Countries' Concerns
» Exchange Rate Policy of Developing Economies
» India's Exchange Rate Regimes and Experiences
» Nominal vs Real Exchange Rates, Bilateral vs Effective
» Exchange Rates and the Economy



3. International Financial Flows
» Emergence of International Financial Intermediation
» Recent Changes in the International finance
» Resource Flows to Developing Countries

4. Emerging Market Analysis
» Country Risk Analysis
» Foreign Investment Analysis: Direct and Portfolio
» Currency Convertibility: Current Account and Capital Account
» South Asian Currency Crisis

5. International Trade
» Developments in International Trade Theory
» Trade Policy Instruments and Liberalization
» World Trade Organization

6. Legal Dimension in International Business

11.14 INTERNATIONAL FINANCIAL MANAGEMENT

Objectives

@ To introduce the environment of international finance and its implications on
international business.

= To analyse the nature and functioning of foreign exchange markets,
determination of exchange rates and interest rates and their forecasting.

@ To define and measure foreign exchange risks and to identify risk
management strategies.

& To explore the sources of long term finance and design financial strategies.
@ To integrate the global developments with the changing business environment
in India.
Topics
1. Intricacies of Foreign Exchange Markets
» Spot and Forwards Exchange Rates

» Eurocurrency and Domestic Interest Rates
»+ Quotations and market rules

2. Parity conditions in International Finance
» Purchasing Power Parity



» Covered Interest Parity
» Real Interest Parity
» Parity Conditions and Managerial Implications

Forecasting Exchange Rates
» Fundamental Factors Affecting Exchange Rates
» Time Series Forecasting Models

International Sources of Finance for the Firm
» Bond Financing (Fixed and Floating Rate Notes)
» Loan Financing (Syndicates Loans)
»  Securitised Financing (Euronote)
» Equity Financing (GDR and ADR)
» Features of Loan Agreements: Loan Negotiations

International Financing Decision
» |ssues in Overseas Funding Choices
» Economic Circumstances and overall Funding Choices
» Funding and Risk Management Aspects

Analysis of International Capital Budgeting, Cost of Capital of a Foreign
Investment

Foreign Exchange Risk Management
» Conceptual Overview
» Nature of Exposure (Economic, Transaction, Translation)
» Hedging and Speculation

Derivatives and Exposure Management
» Currency Forwards
»  Currency Options
»  Currency Futures
»  Currency Swaps
» Interest Rate Risk Management

Framework of Managing Exposures, Accounting Implications of Forex
Transactions

» Derivatives Accounting, Risk Management in a Treasury



11.15 MERGERS, ACQUISITION AND CORPORATE
RESTRUCTURING

Objectives

@ To deal with the most current subject in depth.

@ To inter-link the subject of finance with the major strategic decisions of a
proactive firm.

Topics

Various Forms of Business Alliances

Strategic Choice of Type of Business Alliance

Who should go for Merger and Acquisition and Take-over

Defining and Selecting Target

Pricing of Mergers (Pricing the Competitive Bid for Take-over)

Negotiation/Approach for Merger, Acquisition and Take-over

Contracting

Implementation of Merger and Acquisition

© © N o O~ WD

Managing Post-Merger Issues

=
o

. Legalities Involved in Merger, Acquisition and Take-over

=
=

. Ethical Issues of Merger and Take-over

=
N

. Accounting for Mergers

=
w

. Financing the Mergers and Take-overs

H
N

. Corporate Restructuring

=
a1

. Divestment and Abandonment

11.16 OPTIONS AND FUTURES

Objectives

The course aims to develop an understanding of the importance of financial
derivatives and the institutional structure of the markets on which they are
traded as well as developing the analytical tools necessary to price such
instruments. The course will have three main parts:

@ First, the most commonly traded derivative instruments will be introduced,
and their role in the modern capital markets, in particular for risk



management, explained both from a theoretical as well as practical point of
view.

Second, there will be discussion on the institutional structure of the markets
on which such instruments are traded.

Third, the pricing of the derivatives instruments and the risk characteristics
of derivatives will be discussed in detail.

The course will conclude with a discussion on derivatives application in India,
namely index options and futures, computations of the index and its impact cost,
and the analytical issues relating to trading in Indian markets.

Topics

1.

Definition of Derivative Securities

» Brief history of derivatives, Evolution of Commodity, Currency, Stocks
and Interest Rate Derivatives

» Structure of derivative markets, forwards, futures, options, swaps etc.
Examples of more sophisticated derivatives: barrier options, compound
options, options on futures, swaptions

» Underlying assets: equities, currencies, commodities and interest
rates. Explaining cash Market microstructure and derivative markets,
reasons for trading: risk management, speculation and arbitrage

Market Characteristics

» Futures and Options contract specifications, underlying asset, contract
size, and delivery specifications. Marking to market using margin
accounts. Familiarising with market quotes. Trading Strategies
involving Options and Futures.

» |nterest rate derivatives, Contractual specification: floating and fixed
rate. Valuation of interest rate derivatives.

Derivatives Pricing Theory

» Option Pricing: Black-Scholes formula for option pricing: derivation and
properties.

w Volatility: estimated vs. implied, options on dividend-paying
assets, warrants and convertibles.

= Binomial models for option prices: definitions and terminology.
w Continuous-Time Models.

» Futures Pricing: Pricing by arbitrage: relationship between futures and
spot price (cost of carry and reverse cost of carry), difference between
futures and forward price, futures on dividend-paying assets.



4. Risk Analysis and Management

» Risk Measurement and Management Framework, Option's delta,
gamma, vega, theta, rho.

w Hedging with futures. Derivatives Disclosure: Accounting
Issues in Derivatives.

5. Options and Futures Applications in India

» Structure of Indian stock markets and the operational efficiency of
options and futures, determination of the fair value of futures and
options prices, Interactions between spot equity trading and trading in
derivatives.

» |ndex Options and Futures, constructing an index, methodology of
construction, trading an index. Conditions necessary to improve the
market structure in India and policy interventions.

I1. 17 RISK MANAGEMENT AND INSURANCE

Objectives

The Indian Insurance sector has traversed a full circle. Till 1956, when life
insurance was nationalized, it was totally in the private sector. In 1971, commercial
insurance was also nationalized. After around four decades of this nationalized
monopoly, private sector participation has again been allowed. The ensuing
competition is likely to offer challenging careers for MBAs. This course seeks to
prepare the students for the same.

There are two Kinds of career opportunities: one in the insurance companies per se
and the other in terms of risk management in corporate sector using insurance as
one of the tools. There are also other emerging career opportunities in insurance
marketing and distribution, insurance advisory services and Third Party
Administration (TPA) of insurance contracts.

This course will focus primarily on those concepts, techniques and issues in the
context of a person aspiring for a career in insurance and risk management.
Topics

1. Risk: Alternative Definitions, Types of Risk, Risk Management Process and
Methods

Obijectives of Risk Management
Risk Pooling and Insurance including Review of Probability Concepts

4. Institutions for Insurance and Reinsurance- Economic rationale and
requirements

5. Insurance Laws and Regulation

GO



6. Insurance Pricing
7. Asymmetric Information / Moral hazard / Adverse selection
8. Deductibles/ Co-insurance
9. Life Insurance
10. Auto Insurance, Home Insurance, Worker Compensation / ESIC, Health
Insurance Commercial Insurance: Transport, Marine, Catastrophe, Liability etc
11. Pension Plans
12. Corporate Risk Management and Insurance
13. Actuarial Mathematics
11.18 SECURITY ANALYSIS AND PORTFOLIO
MANAGEMENT
Objectives

The focus of Security Analysis is on how others analyse your companyis securities
on their own. Whereas, that of Portfolio Management is on how investors analyse
your companyis securities in comparison with othersi on the security market. The
course is designed with a view :

< To acquaint the students with the working of security market and principles
of security analysis; and
@ To develop the skills required for portfolio management so as to be able to
judge the competitive position of firms in capital market and review the
related business decisions.
Topics
1. The Role of Security Markets in Economy
2. The Organization and Mechanics of Indian Security Markets
» Various Securities and their Characteristics
» Objective of the Security Analysis
» Functions of an Organised Security Market
» Mechanics of Security Trading
3. Various Types of Security Markets and their Functions

» Stock Exchanges
» OTCEI
» Depository

@



4. Role of SEBI with regard to Secondary Markets

5. The Role and Functions of Various Players and Agencies in the Secondary
Market

6. Risk and Return
»  Utility Theory
» Portfolio Theory
» CAPM
»  APT
»  Multi-factor Models

7. Options and Futures

8. Security Analysis
» Fundamental Analysis

w |Internal Value and Market Value of Various Securities;
Internal Value and Market Value of Firm

w Pricing of Security (IPOs and Seasoned Equity Open)
= Financial Statement Analysis

w Projecting Earnings under Stable as well as Dynamic
Conditions, including Risk and Inflation Factors

w The Risk Factors, including Internal Risk
» Technical Analysis of Security Pricing
» Market Efficiency and Behavioral Finance

9. Portfolio Management
» Portfolio Theory
w Portfolio Criteria
w Efficient Set
w Portfolio Selection and Diversification
w The Shape and the Risk Function (including CAPM Model
Technical Analysis, Random Walk and Martingale Model)
» Portfolio Management
w Portfolio Objective
w  Size of Portfolio
w Selection Basis and Readjustment
w Timings of Disinvestment

10. Market Microstructure

€



11.19 VALUE AT RISK
(Half-Credit Course)

Objectives

@ Sensitize about the different types of market risks (FX risk, interest rate risk,
equity risk as well as credit risk)

@ |ntroduce the concept of Value-at-Risk and its measurement issues
@ Explain the statistical concepts as applicable to risk measurement
< Application of VaR applications to manage risks

Topics

Risk Management : An Overview

Concept of Value-at-Risk

Computation of Value-at-Risk

Stress testing and backtesting

Calculating portfolio risk

Parametric, Monte Carlo, and Historical simulation
Using Value-at-Risk to establish trading limits
Using implied volatility in Value-at-Risk measures
Credit Risk Management and Credit VaR
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10. Credit Exposure : VaR on Contingent Claims
11. Risk reporting and management

12. Indian regulatory environment in VaR applications



I1l. GENERAL MANAGEMENT

I11.1 BUSINESS LAW

Objectives

The objective of this course is to provide the students with practical legal knowledge
of general business law issues and topics to help become more informed, sensitive
and effective business leaders. As the business managers are called upon to create
value, marshal resources and manage risk, it is imperative that they should
understand fundamental legal issues pertaining to business world to enhance their
ability to lead and delegate. A sound knowledge of the law is a strategic asset which
if timely and properly applied will provide, the prospective managers and their
organizations, immediate and long-term benefits and the ability to avoid costly
mistakes.

Topics
1. Contract Act
»  Contract vs. Agreement
» Element of valid contract
»  Offer and Acceptance fi Rules regarding revocation of offer and acceptance
» Standard form contract i a new innovation to suit the needs

» Consideration A Essential elements. Exception to the Rule A No
consideration no contract i Privity of contract and consideration

» Capacity to contract

» Free consent i Coercion, undue influence , misrepresentation, fraud.

» Mistake fi as to identity, as to subject matter, as to nature of promise

» Legality of the object fi void agreement, voidable agreement, agreements
opposed to public policy

» Discharge of contract A modes of discharge, by performance, by
impossibility, by agreement, by breach

» Damages i Rules, remoteness of damages, measure of damages,
liquidated damages and penalty

» Quasi contract or certain relations resembling those created by contract
=+ Bailment ii Duties of bailer & bailee
» Law relating to agency - types of agency, agentis responsibility and rights

2. Companies Act, 1956
» Company i meaning & characteristics and kinds
» Lifting the corporate veil

©,



» Registration & Incorporation

»+ Memorandum of Association

=+ Doctrine of Ultravires

» Consequences of Ultravires transaction

»  Articles of Association

» Rule of Constructive Notice

» Doctrine of Indoor Management

»  Prospectus

»+  Shares

»+ Shareholders & Members

» Directors : Position, appointment, removal, power & duties
» Meetings

»  Majority powers & minority rights

» Prevention of oppression and mis-management
»  Winding up

»  Winding up by court

» Voluntary winding up

»  Winding up subject to supervision of court

» Conduct of winding up

3. Partnership Act, 1932
» Nature of partnership
» Relation of partners i Inter se
» Relation of partners to third parties
» |ncoming and outgoing partners
»  Dissolution of firm
» Registration of firms

I11.2 BUSINESS RESEARCH METHODS

Objectives

% To understand the concept and process of Business research in business
environment.

% To know the use of tools and techniques for exploratory, conclusive and causal
research.



& To understand the concept of measurement in empirical systems & its validity
and reliability.

% To use statistical techniques for analysis of research data.

@ To realize the applications of Business research.

Topics

1. Introduction to Business Research, Definitions, nature, scope

2. Concept, Significance

3. Research Process, Research Design

4. Exploratory Research : Focus Group, Projective Techniques, Depth Interview,
Observation, Case study method, Secondary data collection and analysis

5. Problem Discovery ~ Problem Definition, Hypothesis Formulation

6. Causal Research, Experimental Designs

7. Questionnaire Construction

8. Measurement, Basic scales, Validity Analysis, Reliability Analysis, Attitude
measurement scales

9. Sampling

10. Field work, Non-sampling errors, how to overcome them, Data preparation and
preliminary analysis

11. Introduction to Multivariate Analysis

12. Factor Analysis, Regression Analysis, Cluster Analysis, Correspondence
Analysis, Conjoint Analysis

18. Reporting and Concluding Integration



111.3 MANAGERIAL COMMUNICATION

Objectives

e To enable the students to become aware of their communication skills and
sensitize them to their potential to become successful managers

< To introduce them to some of the practices in managerial communication
that are in vogue

@« To help them acquire some of the necessary skills to handle day-to-day
managerial responsibilities, such as

making speeches,

controlling one-to-one communication,

enriching group activities and processes,

giving effective presentations,

writing letters, memos, minutes, reports and advertising, and

maintaining one's poise in private and in public

ONOCNONONONC

< To build their confidence and to install competitiveness by projecting a
positive image of themselves and of their future.

Topics
1. Introduction to managerial communication

2. Principles of nonverbal communication
» through clothes and
» body language

3. Types of managerial speeches
» speech of introduction
» speech of thanks
» occasional speech
» theme speech

4. Mastering the art of giving interviews in
» selection or placement interviews
» discipline interviews
» appraisal interviews
»  exit interviews

5. Group communication by way of
» meetings
» group discussions

6. Introduction to managerial writing



7. Business letters
» routine letters
» bad news and persuasing letters
» sales letters
» collection letters
» job application letters

8. Internal communication through
»  memos, minutes, notices
»  reports

9. Principles governing the use of audiovisual media
10. Principles of Effective Presentations

11. Business and social etiquette

1.4 MANAGERIAL ETHICS

Objectives

This course aims at helping students think about some of the important ethical
implications of the day-to-day happenings and practices of Indian industry and
business. It is designed to stimulate discussion and debate rather than to
formulate principles, and to raise further questions rather than to dictate
answers. The following objectives are underlined:

@ To improve ethical reasoning by correlating moral concepts to business
practices - clarification of the values that determine managerial behaviour.

< To sensitize the fundamental human values in analysing social problems and
appraising global issues.

@ To recognise the variables in most ethically complex business situations
through an understanding of the more subtle criteria for making sound
decisions.

Topics

1. Introduction: Two Learning Models

2. Individual Ethics

» Ethical Dilemmas in Management

» Ethics in Corporate Strategy
= Discussion: Head & Heart Traits in Decision-making

» Value Clarification for Future Managers - Two Models
w Discussion: Ethical Attitudes of Management Students



3. Group Ethics

>+

>+

Ethical Attitudes of Indian Managers
w Discussion: Ethical Attitudes of the Local Managers: A Study of
the XLRI Alumni
Managers Facing Unethical Management
w Discussion: Group-think and Unethical Behaviour

4. Corporate Ethics

>+

>+

Ethics and Company Philosophies
w Discussions: Corporations and the game theory approach

Corporate Social Responsibility : Meaning and History

5. Application

>+

>+

Marketing Ethics
w Discussion: Bluffing in Indian Marketing Practices

Ethical Issues in Advertisements
w Discussion: Subliminal Advertisements : The Indian Way

Marketing Research Ethics
w Discussion: Commercial Intelligence-Gathering and Espionage

Ethics in Finance : Ethics in Tax Planning and Financial Statements
= Discussion: Speculation and Insider Trading

Ethics in Information Technology and Systems Usage

6. Global Social Issues

>+

Environmental Ethics
w Discussion: Environmental Activism in India

Economic Justice and Business Ethics
w  Discussion: Distributive Justice and India

Corporation and National Problems
w Discussion: Ethics in International Technology Transfer

Ethics of Multinational Business

GP: MNCs as a sign of Contradiction
w Discussion: The MNCs and The Indian Experience

Social and Ethical Issues in Genetic Engineering
w Discussion: Intellectual Property Rights

Working at Cracks: Managers with a Difference



1.5 ART OF PUBLIC SPEAKING

Objectives

@ To give a solid and theoretical understanding of the elements of a good
speech.

& To provide opportunities to students to practise making speeches of different
kinds.

< To develop self-confidence and even a certain pleasure in public speaking

@ To help students develop skill in the art of writing speeches.

Topics
1. Importance of Public Speaking
2. Theory of Effective Oral Communication

3. Elements of Effective Communication
» ldea
»  Word
» Delivery
»  Posture
»  Gestures
» The Art of Informing or Persuading

4. Speech Composition

» Introduction
»  Body
»  Conclusion

How to Develop Matter for a Speech

Overcoming Nervousness

5
6
7. Use of Humour
8. Audience Feedback
9

Speaker Credibility



I11.6 CORPORATE IMAGE BUILDING

Objectives

@ To bring out importance of image building for an organization.
< To identify the components which make-up an image.

< To trace some of the processes involved in creating image.

@ To evolve some strategies for projecting a positive and consistent image of an
organization and its personnel.

Topics

1. Corporate Image in Contemporary Management Studies

2. Components of an Individual Image

3. Advertising and Corporate Image

4. Public Relations of an Institution

5. The Grapevine and Rumours

6. Stereotype

7. Propaganda

8. Case Histories of Corporate Images in Private and Public Sectors

I11.7 EMOTIONAL INTELLIGENCE AND
MANAGERIAL EFFECTIVENESS

Objectives

There is a mounting body of evidence that emotion is the most powerful resource
we have. Emotions are lifelines to self-awareness and self-preservation that deeply
connect us to ourselves and others, to nature and the cosmos. Emotional intelligence
is the ability to sense, understand, and effectively apply the power and acumen of
emotions as a source of human energy, information, connection, and influence.

This course will enable the students to become aware of the sources of emotions
and learn how to deal with human emotions. Making use of Enneagram typology,
the course will focus on the managerial competencies and their emotional
impacts.



Topics
Introduction
Emotions and the Tripartite Brain
Emotional competencies

Executive EQ

Rational Emotive Therapy
Emotional transformation

1

2

3

4

5. Emotions and Enneagram
6

7

8. Script analysis using Enneagram
9

Measuring Emotional Intelligence
10. Emotions and childhood
11. Role of Emotions

12. Emotions and attitudes

111.8 MARKETING LAW

Objectives

The Law and our legal system have a pervasive impact on marketing activities.
Decisions of marketing executives frequently raise issues which should be carefully
evaluated as to their legal consequences before they are implemented. The failure
to appreciate these legal implications can lead to seriously damaging, if not
disastrous, results for a firm.

The approach of this course would be to address National Laws and court decisions
that relate to the four main areas of marketing study, the so-called i four Pis i of
marketing: product, price, place and promotion.

Topics
1. Legal Issues Relating to Product Quality and Material Movement
» Conditions and warranties

» |mplied Conditions
» Rule of Caveat Emptor [ Buyer Beware ]



Rules

>+
>+
>+

>+

Transfer of Title

Nemo Dat Quod Non Habet

Sea Transit : FOB, CIF, Ex. Ship
Rights of Unpaid Seller

Lien

Stoppage in Transit

Right to Resale

Remedies

Relating to Hire- Purchase
Position of Parties to Hire Purchase
Conditions and warranties
Limitation on Hire Purchase Charges
Passing of Property

Laws Relating to Common Carrier

»+

»+

»+

Definition of Common Carrier
Distinction between Common Carrier and Pvt. Carrier
Liabilities of Common Carrier

Legal aspects of Delivering Goods for Carriage and Warehousing

»+

»+

Rights of Warehouse
Duties and Liabilities of Warehouse

Rights to do any Trade or Business

>+

>+

>+

Fundamental
Legal
Restrictions

Restraint of Trade

»+

»+

»+

>+

Knock i Out Agreement

Trade Combination

Solus or Exclusive Dealing Agreements
Restraints upon Employees

Law Relating to Services Marketing

»+

»+

Concept of Service
Deficiency in Service



Real Estates
Hospital

Carrier

Courier

Bank

Transport Service

8. Legal Aspects of Restrictive Trade Practices

>+

>+

>+

>+

>+

>+

Tie-in Sales or Full Line Forcing
Price Fixing

Predatory Pricing

Exclusive Dealing

Territorial Restriction

Refuse to Deal

9. Legal Aspects of Unfair Trade Practices and some aspects of Advertisement

»+

»+

»+

»+

»+

>+

False and Misleading Representation

Bait Advertising and Bargain Price

Offering Gifts and Prizes and Conducting Promotional Contests
Withholding Information about Final Results of scheme
Hoarding and Destruction of Goods

Spurious Goods

10. Competition Law

»+

»+

»+

Introduction

Meaning

Anti-competitive agreement

Anti-competitive agreement : Competition within India & Effects Doctrine
Anti-competitive agreement : Horizontal

Anti-competitive agreement : Fixing prices

Anti-competitive agreement : Vertical Agreements

Anti-competitive agreement : Limiting and Controlling Production &
Investment

Acquisition, Merger & Amalgamation
Anti-competitive agreement & WTO



111.9 NEURO LINGUISTIC PROGRAMMING

Objectives

NLP recognized as a regolutionary approach helps people modify their thought and
behavioural style to accomplish their goals through observation of language pattern
and non-verbal cues. Using NLP you can master powerful techniques of persuasion,
negotiation and eliminate fears or phobias and low self-esteem. It helps you
reprogramme your mind and your life for faster learning, better relationship and
greater achievement. NLP, in short, helps you become more successful in any area
of your life and business.

NLP is a rapid means of enhancing executive performance. It is a technology that
literally works at the level of how the individual thinks. The NLP practitioner is
able to observe with an acuity that is quite startling to the observer who is not
attuned to noticing the tiny body language cues that are the expressions of the
thinking process. Once trained in how to make sense of the micro changes in the
ways people express their thinking, the practitioner can use a variety of NLP
techniques to add to or enhance the repertoire of any personis thinking process.
Everyday behaviour such as being pleasant, decisive, strategic, persuasive and
other staples of how we think our way through the day are accessible to change and
improvement.

Topics

Creating a vision

Developing self-confidence

Writing your own life script

Building a positive attitude

Establishing strong relationships

Seeing your customer through the eyes of the customer

Building a climate of trust

Strategies for persuasion
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V. HUMAN RESOURCE MANAGEMENT

IV.1 PERSONNEL MANAGEMENT & INDUSTRIAL
RELATIONS

Objectives

& To create an understanding of the various aspects of the management of
human resources, their interaction in the execution of managerial
functions.

@ To facilitate learning of various concepts and skills required for utilization
and development of human resources for organizational functions.

& To impart basic knowledge of the Indian Industrial Relations System.

@ To build awareness of certain important and critical issues in the Indian
Industrial Relation System.

@ To provide an exposure to the required skills for managing Industrial
Relations.
Topics
1. Personnel and HRM
» Philosophy - Peace, Happiness and Prosperity only through HRM
» Strategic Purpose and Business Objectives
» |ts Position in the Organization
» Line and Staff Linkages and Responsibilities
» Factors influencing HRM
2. Manpower Planning for Organizational Development
» Challenges
» MPP and Its Organizational Linkage - Macro and Micro Levels
» Process of Planning
» Procedures and Steps for an Effective Planning through
w Acquisition and Analysis of Data and Information
w Designing and Implementing Plans and Actions

w Controlling and Evaluating



3. Employment Function

» Challenges

» Recruitment - internal vs. external

»+  Selection

»+ Placement

» |nduction (Employees' Awareness) Programme
4. Evaluation and Career and Succession Planning

» Performance Appraisal System (PA)

» Performance Appraisal Process

» Career Management
5. Training and Development (T and D)

» Need for T and D

» |ndividual vs. Organisational needs

» Training Objectives and Strategies

» Training Methods and Techniques

» Design and Organisation of Training

w Evaluation of Training

6. Compensation System (Pay and Benefits)

» Some Thumb Rules about Compensation System

» |mplementation and Administration of Compensation
7. Industrial Relations System

» |ts Structure, the Actors, their Interrelationships

State, Trade Unions & Employersi Organisations
Grievance Management

»+ Nature and Causes of Grievance

» Practice and Procedure of Handling Grievance
10. Discipline

»  Approach to Discipline

» Disciplinary Proceedings (Domestic Enquiry )



11. Industrial Conflict and its Resolution
» Nature of Conflict and its Manifestation
w Dispute Settlement Methods:
w Collective bargaining
w Conciliation, Adjudication, Arbitration
12. Industrial Democracy

» Workers Participation: Form, Level, Governmentis Policy

IV.2 LABOUR LAW APPLICATIONS

Objectives

To expose the students to a variety of IR situations with special reference to
disciplinary action, discharge, dismissal and other related matters and to equip
them with the necessary tools to apply the law to a given a set of facts.

Topics

1. Analysis of the terms "Industry” and "Industrial dispute”

2. Industrial Discipline : Introduction

3. Misconduct

4. Disciplinary proceedings

5. Domestic Enquiry : Contents and Process

6. Principles of Natural Justice

7. Case Law Reference

8. Right of workmen under S. 2-A : The scope of S. 11-A, Restricted vs. enhanced

powers of tribunals, "Materials on record" : meaning of - Right of the parties
to adduce evidence before the tribunal - What are the implications of the
expressions "lesser punishment" and "compensation"? - Implications of
S. 17-B.

9. Nature and scope of Ss. 33 and 33-A : Discharge/dismissal during the
pendency of a proceeding, workman concerned in the dispute : who is ? -
miscounduct connected with the dispute : what is ? - prior permission vs.
post-facto approval of the action - protected workman : who is ?



Objectives

V.3 MANAGERIAL COUNSELLING

This course aims at developing the professional counselling skills among the
students by:

@ Providing an overview of the counselling processes and techniques.

@ Creating a forum for practising the basic counselling skills.

@ Selecting the key areas and situations where management can and should
help employees in performance planning and career advancement.

< Developing alternative approach to dealing with problem situations in
organisations.

Topics

1. Self-Development of Managers as Counsellors

>+

»+

»+

Barefoot Counselling
Assertiveness and Interpersonal Skills for Counsellors

Counselling Relationship

2. Development of Counselling Skill

>+

>+

»+

»+

»+

Introduction to the Important Schools of Counselling
Psychoanalytic Foundations

Transactional Analysis

Gestalt Therapy

Rational Emotive Therapy

Person-Centred Approach to Counselling

An Integrated Model

Essentials of Skills

Nonverbal Clues

3. Counselling Interventions in Organisations

>+

»+

»+

Empathy
Listening and Responding

Effective Feedback



» Performance Counselling

» Counselling in Problem Situations
» |Interpersonal Conflicts

=+  Midlife Blues

» |ntegration and Action Plan

IV.4 ORGANIZATIONAL CHANGE AND
DEVELOPMENT (OC & D)

Objectives

The purpose of this course is to learn to plan and implement change at the
individual, group and organizational level. The course is designed to help the
students develop as potential change agents and OD professionals. After
completing this course you should:

@ be able to understand the theory and practice relating to the processes of
organization development and change.

@ develop insight and competence in diagnostic and intervention processes
and skills for initiating and facilitating change in organizations.

& gain necessary self-insight, skills and techniques to become effective change
agents and internal OD consultants.

Topics

1. Introduction

2. Planned Organizational Change

3. Foundations of OD

4. Entry and Contract

5. Organizational Diagnosis

6. Feedback and OD

7. OD Interventions: An Overview

8. Individual and Interpersonal Interventions
9. Team / Group Interventions

GO



10. Intergroup Interventions

11. Comprehensive Interventions

12. Organizational Transformation

13. The OD Consultant: Role, Skills and Dilemmas
14. Success and Failure of OD

15. Future of OD & New Perspectives

IV.5 PERFORMANCE MANAGEMENT

Objectives

Develop skills for managing performance of employees i.e. Appraising,
Compensating & Developing employees (Developing employees being a separate
elective course will not be dealt in this course)

Appreciate performance management in the context of the organizational
objectives

Topics

1. What is Performance Management? Its linkage with other HR Systems

2. Elements of Performance Management

Defining Performance, Facilitating Performance and Encouraging
performance

» Setting Goals & Targets

» Responsibilities before, during, after Performance & Development
planning

3. Monitoring and Appraising Performance (Performance Appraisal)
» What is Performance Appraisal
» The Performance Appraisal system
» Performance Appraisal Methods
» Errors and Biases in Performance Appraisal
» Reducing biases / errors

» Features of a effective system

&



» Performance Counselling
(What is it, What to do, What not to do)

4. Compensating Performance

5.

» Performance management and compensation strategies

» What is compensation

» Designing compensation systems

(=3

=

Compensation and dimensions

Legislation and compensation

Job analysis, Job description, Job evaluation techniques
Compensation surveys, Compensation policies

Designing pay structures
(Pay policy line, Pay grades, Broadbanding)

Pay for performance / Pay for knowledge Seniority / Merit

Incentives and benefits

Incentives

Individual incentives plants
Piecework

Group incentive plans
Scanlon plan, ilmprosharei plan

Enterprise incentive plans
ESOPs

Benefits
Types of benefits
Employee benefits required by las
Discretionary major employee benefits

Employee services, Health care, Long term care

Requirements of an effective benefits programme
Concerns of management

» |mportant issues in

(=3

(=3

Executive compensation

International compensation

Issues and concerns in Performance Management

&



Topics

IV.6 RECRUITMENT AND SELECTION

1. Introduction

»+

»+

>+

Importance of Human Assets

Human Capital

Human resource as fixed assets/costs

Human capital appreciates and not depreciates

Human capital could be asset or liability depending on quality of
selection

Quality of human asset determines the market force/market
appreciation

Quality of human asset determines the success or failure of an
organization

Hence, selection of right man for the right job is extremely important

Selection and placement constitute one of the most important key
function of H.R. Management.

2. Purpose/Objective of selection

»+

>+

>+

»+

Identify the need

Explore possibility of filling up the need internally

Examine effect of non-filling up a position

Assess the expectation/output from the position

Strictly ensure the fullest use of the identified manpower need

Remember always the idle manpower is a non-performing asset and
could be reduced to a great liability

Hence, careful Manpower Plan is essential which is a prerequisite
to selection

Importance of cost and speed of Selection Program.

3. Preparation

>+

To prepare Position Description to identity:

w Purpose of the job;



4. Job Analysis

Job responsibility;

Job expectation;

Job duties in greater details;
Reporting relationship;

Job requirement in terms of skill, personality, attitude,
language, locality etc.

» Analyze the job requirement to identify Competencies relevant for

the job:

=

=

(=3

(=3

Skill competency;
Attitudinal competency;
Managerial competency;

Functional competency

5. Person Specification

» What Kkind of person would be most suitable?

6. The requirements

>+

>+

»+

Age range

Education

Special aptitude, if any

Language preference, if any

Work experience

Placement locality

Any other specific requirements such as:

=

=

(=3

=

Need to work in shifts;
Need to tour extensively;
Need to work longer hours;

Gender exclusion (i.e. female not suitable)

7. Company Information

» Company image



»+

»+

Type of business

Products manufactured and distributed

Company turnover

Company philosophy, vision, mission and broad objective
Information

Gross Compensation range - Cost to the Company (CTC)
Industry Competitive

Negotiable

Retiral Benefits

Stock Option (ESOP)

9. Career Opportunity

10. Company Philosophy - Growth from Within

11. Sourcing
»  Office notice displayed at various units at conspicuous places;
»+ Press Advertisement under Classified Columns or General Columns’
» Career fair organized by reputed media agency/House;
» Recruiting agency firms;
» Forced/Unsolicited applications;
» Employee referral;
» Head hunting - to identify specific target points;
» Direct personal contacts;
» State Govt. agency (Employment Exchange);
» School/College/B-School - Campus selection;
» |In-house Data Bank (Company).

12. Screening of CVs/applications received

»+

»+

Short-listing the most probable candidates;

Make an ABC analysis in terms of most suitable to least suitable list
of candidates;

Determine interview centers keeping in view cost parameters and

candidatesi convenience;



>+

Issue interview letters specifying venue, date and time. Also, indicate
Company expense reimbursement policy clearly.

13. Selection Test & Interview

»+

Prepare list of competencies to be checked during interview/selection
tests;

Prepare suitable test methods relevant for checking competencies;
Identify interviewers with sufficient job knowledge;

Brief Training of Interviewers regarding essentials of interview;
Prepare standard interview (assessment form relevant for each case)
Prepare competency checking module;

Determine suitability of group interview/individual interview;

Prepare list of merits and demerits of individual versus panel
interview - then examine the most suitable one;

Training of interviewers on 'ESSENTIALS' for conducting interview;

Collate the results of the interview to determine the most acceptable
candidate;

Remember always the essence of successful interview is an unbiased
mind of an interviewer - this needs to be checked and balanced;

14. Relative merits and demerits of some of the common methods of Psychometric

test

>+

»+

»+

>+

Personality test;

Group discussion;

Extempore speech;

Individual question and answer session;
Written test;

On the job test;

Role playing.

15. Building up competency module and appropriate test for selection at the
following level of jobs

»+

Very senior level (General Manager and above)

GD



16. Others

>+
>+

»+

Objectives

Middle management level (manager/senior manager)

Junior functional like Computer Operation, Stenographers/
Secretaries/Clerical staff, etc.

Worker level- skilled/unskilled category/office peons/security staff,
etc.

Antecedent checking;

Medical fitness checking;

Negotiation of remuneration package;

Explaining terms of contract and obtain agreement;
Issue of appointment letters;

Explain Company policy on joining expenses;

Arrange for welcoming the new entrant on the date of joining and
introduce with all concerned employees of the company;

Prepare a short induction to enable him to settle down in the
organization;

Determine the induction elements.

IV.7 STRATEGIC HUMAN RESOURCE
MANAGEMENT

The objective of the course is to develop the perspective of strategic human
resource management. Specifically the course has the following objectives:

< Distinguish the strategic approach to human resources from the traditional
functional approach.

< Understand the relationship of HR strategy with overall corporate strategy.

@ Understand the strategic role of specific HR systems.

@ Appreciate SHRM in the context of changing forms of organisation.

Topics

1. Business Strategy and Organizational Capability



2. Global Environment of HR: Change and Diversity

3. SHRM: Aligning HR with Corporate Strategy

4. SHRM: Universalistic, Contingency and Configurational Approaches

5. Strategic HR Planning Acquisition and Development

6. Corporate Strategy and Career Systems

7. Managing Employee Relations: Unions and Strategic Collective Barganing
8. Change, Restructuring and SHRM

9. Corporate Ethics, Values and SHRM

10. Competencies of HR professional in a SHRM scenario

11. Evaluating the Effectiveness of SHRM

IV.8 TRAINING AND DEVELOPMENT

Objectives

In the context of global competition, organizations are committing more
resources, in the forms of both time and money, towards training and development
that enables employees to continuously update and develop their competencies.
The present course is designed to study the concepts, processes and practices of
training and development (T&D).

The main objectives of the course are :

@ To enable you understand the concepts and principles of T&D in the context
of Human Resource Development (HRD) and linkages of T&D with other HRD
processes.

@ To develop an understanding of how to design, organize, implement and
evaluate training in an organizational setting.

@ To familiarize you with the tools and techniques involved in T&D and help
you to apply them to real life situations.

The endeavor is also to provide, as far as possible, a hands - on (or vicarious)
learning experience related to aims. On completion of this course, you will be



confident to develop and implement result - oriented training programs in the
organizations.

Topics

Introduction

A Systematic Approach to Training

HRD Trends, Strategy and Training

Needs Assessment and Analysis

Objective Setting

Designing Training Programs

Learning Environment

Instructional Techniques - An Overview

© ® N o 0k~ 0w bR
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Objectives

V. INFORMATION SYSTEMS

V.1 BUSINESS COMPUTING

< Familiarizing the managers with basic computer concepts and emerging
computer technology, so as to enable them to use computer resources efficiently
for making effective decision.

@ Providing the necessary skills to understand and use various commonly used
software in various functional areas in an organization.

Topics
1. Theory
»+

»+

»+

sessions
Introduction to Computing & Data Representation
Computer Architecture: Input/Output, Processing & Storage

System Software: Operating System, Interpreter, Compilers etc. basic
concepts

Software Development Methodologies

Workshop: How to select an Information System

Advantage and Disadvantage of IT Outsourcing
Telecommunication Concepts, Data Transmission and OSI layers

Local Area Network (Ethernet, Token bus, Token ring) Wide Area
Network, TCP/IP fundamentals

Internet, Intranet, Extranet, The World-Wide Web

Introduction to ERP: The critical success factors for ERP implementation
Introduction to e-Commerce/e-Business

e-Security for Business Continuity

Future Trends of IT

2. Lab Sessions

»+

>+

>+

Developing business presentation with MS-PowerPoint
MS Excel

MS Access

Network trouble sorting

SPSS



V.2 MANAGEMENT INFORMATION SYSTEMS

Objectives

@ To create an awareness in upcoming managers, of different types of information
systems in an organization so as to enable the use of computer resources
efficiently, for effective decision making.

% To understand various MIS operating in functional areas of an organization and
explain its relationship with the various activities of the organization.

@ To understand how MIS is developed and implemented for various levels in an
organization.

@ To explore the use of some common IS development tools.

Topics
1. Management and Systems
»  Advance in Management
» The process of MIS Development
» MIS Organization
» |Information Dynamics

2. Planning
» Design and Implementation of MIS
» |S Strategic Planning
» MIS Design - Gross Design Concepts
» Detail Design Concepts
» MIS Implementation
»  Acquiring Information Systems : Contemporary Approaches

3. System Life Cycle
=+ |nformation Flow
» Entity Relationship Modeling
» Data Modeling
» Detailed Process Analysis
» Data Flow Diagrams

4. Decision Making with MIS
»  System Concepts for MIS
» Data
» |nformation and Communication
» Problem Solving and Decision Making



5. IS Security, Control System Success and Failure

6. The Future Trends in MIS
» The Emerging IT Trends
» Electronic Data Interchange
»  Objected Oriented Approach
» Networking (Information System Highway)
» Extended Enterprise Systems
» Managing International Information Systems

V.3 BUSINESS AND DATA COMMUNICATIONS
NETWORKS

Objectives

The convergence of computing and telecommunication technologies revolutionized
the field of IT. We have witnessed the impact of it in business practices in the last
decade. The business that used to be conducted over private telecommunication
systems has been moved onto Internet-based data communication networks. The
world has shifted from a broadcast to interactive paradigm. People have started
providing personalized service economically. Market has become boundary less. In
all these, ICT has taken the central role. As predicted by experts, the demand for
ICT products and services are increasing exponentially and keeping pace with this
demand, the technology is also developing. Currently, for a problem, more than one
technological solution is available to a business organization. The wide use of this
technology will make it pervasive in the near future.

The purpose of this course is to familiarize students with the concepts of
communication networks. Here, students are expected to learn the theoretical
background of the Data Communications and Networking, and their application into
business organization along with issues related to the next generation network.

Course goal is to make the students acquainted with the following :
@ Computer and telecommunication technology

< Market for communication services

@ Recent trends in this communication service market

@ Challenges related the available technologies



Topics
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Introduction

Fundamental to Digital Data Communications

Introduction to Communication Protocols and OSI Reference Model.
Choice of Communication Media

Techniques to Ensure Reliable Data Communications

Different LAN Technologies- merits and demerits

Network Topologies, Types of Networks, Network Components
Control and Operational Issues in Data Communication Network

Addressing Schemes for Internet

. Design and Technology of Back Bone Networks

. Current and Next generation Networks and Related Issues (Infrastructure)
. Current and Next generation Networks and Related Issues (Mobility)

. Techniques for Network Operation and Management

. Pricing of Network Services

. Pricing models for Network Bandwidth

. Case - (Network) to Derive Competitive Advantages

. Telecommunication Market and Regulation Prevailing in India (TRAI)

V.4 BUSINESS MODELING THROUGH SYSTEM
DYNAMICS

Objectives

This introductory course on Business Modeling Systems Dynamics (BMSD) has been
designed to impart skills of model based system enquiry to the students. In this
course, the students will have an opportunity to

&

&

&

&

Define System Models and to create System Models
Learn to apply Systems Models to problems
Learn to recognize opportunities to intervene in and improve systems

Explain the value of Systems Dynamic approach in business today



Topics
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Introduction

System Dynamics Paradigm

System-concepts and theory

Elements of system dynamics modeling

Causal loop diagramming

Game- Beer Game

Behavior of linear low-order system-analytical solution
Learning of a simulation tool

Hands on with a simulation problem

. Steps in system dynamic modeling

. Steps in dynamics modeling

. Building and simulating system dynamics models

. Validation of system dynamic models

. Business Case i Revenue growth for a restaurant

. Business Case- Software development schedule overrun

. Business Case- Indian Tea industry

. Business Case i Environmental impact analysis caused due to industrial growth
. Business Case fi Stock price movement

. Challenges for system dynamics and discussion.

V.5 CYBER LAW & I PR

Objectives

At the completion of this course the student will be able to:

&

Identify the emerging legal issues in a digital networked environment including
general issues of jurisdiction and enforcement of rights and liabilities in
cyberspace;



@ Consider developments in specific areas of law arising in cyberspace including
intellectual property, regulation of content /censorship, privacy and electronic
commerce;

@ Understand and evaluate how these developing concepts affect the flow of
information in society and the work of information professionals;

< |dentify and analyze recent developments in national and global information
policy, the nature of the policy making process and the identities and positions
of the various stakeholders;

@ Consider the role of the information professions in this policy making process;
and

< |dentify and evaluate resources and materials treating the Law of Cyberspace.

Topics

1. UNCITRAL Model Law

2. Introduction To Information Technology Act, 2000

»  Object; Scope; Scheme Of The Act; Relevancy With Other Laws.
3. Jurisdictional Issues
»  Civil Jurisdiction; Cause of Action; Foreign Judgment; Exclusion Clause
of Contract; Jurisdiction Under IT Act, 2000.
4. Digital Signature: Technical Issues & Legal Issues
» Digital signature; Digital signature Certificate; Certifying authorities
and liabilities in the event of Digital signature Compromise;
E- Governance in India.
5. Concept of Cyber Crime & the IT Act,2000
» Cyber Crimes: Technical Issues; Cyber Crimes : Legal Issues; Cyber
Crimes : Legal Issues [ Penalty under the IT Act ]; Cyber Crimes : Legal
Issues [ Offences under the IT Act ]; Cyber Crimes : Legal Issues [Offences
under IPC ]; Cyber Crimes & Investigation; Cyber Crimes & Adjudication.

6. Contract in the InfoTech World

»  Status of Electronic Contracts; Click iWrap And Shrink i Wrap Contract;
Contract Formation In The Internet Vis- A fiVis Contract Law.
7. Protection of Cyber Consumers in India

»  Are Cyber Consumers Covered Under The Consumer Protection Act ?;
Goods and Services; Defect in goods and deficiency in services; Restrictive
and unfair trade practices; Consumer Foras, Jurisdiction And
Implications On Cyber Consumers In India.



8.

9.

Evidence Law vis-a-vis IT Law

» Status Of Electronic Record As Evidence; Proof And Management Of
Electronic Records; Relevancy, Admissibility And Probative Value Of E-
Evidence; Proving Of Digital Signature; Proving Of Electronic Message

IPR Issues in a nutshell

»  Copyright Issues; Patent Related Issues; Trade Mark Issues; Design
Related Issues

10. European Convention On Cyber Crime

11. Role Of Interpol In Cyber Crime

V.6 DATA STRUCTURES

Objectives

& The course is about structuring and organizing data as fundamental aspect of

developing a computer application. The course will cover numerous structures,
techniques and algorithms.

Topics

©

N o g M w NP

Fundamentals of Data Structures

Abstract data types

Complexity of Algorithms

Array, List Stacks and Queues: implementation
Recursion: Recursive program, simulating recursion
Trees: A VL-Tree, B-Tree

Graphs: Representation of graphs, shortest path algorithms, minimal spanning
tree algorithms, depth-first and breadth-first search

Searching: Sequential search, Binary search

Sorting: Elementary sorting methods, heap-sort, quick-sort, merge-sort and their
analysis, lower bound on complexity.



V.7 DATA WAREHOUSING AND DATA MINING

Objectives

< |dentify the use of data warehousing and data mining in different business
applications

< ldentify the different data warehouse architectures and data warehouse models
@ Recognize the various data mining techniques.

< Know how the data mining is useful in an e-commerce environment.

Topics
1. Data Warehousing
» Introduction and general principle
» On-line Transaction Processing (OLTP)
» Data Warehouse (DW) architecture fundamentals, Data Mart
»  Approaches to architecture
w Top-down, centralized
w Bottom-up, Architected

2. Data Warehouse process
»+ Technical and business Meta Data
» Meta Data process
» Data Warehouse Design
» Star and Snowflake schemas
» Online Analytical Processing (OLAP) architecture
»  Multidimensional Database (MDD), Data cubes
»+ ROLAP data model
» MOLAP data model, Logical Models for multidimensional information
» Conceptual Models for multidimensional information

»  Query & Reporting, Executive Information Systems (EIS), Data Warehouse
and business strategy

3. Data Mining (DM)
» Fundamental concepts, Architectural aspects of Data Mining
» Data Mining techniques
» Data Mining issues and challenges

4. The Business Context of Data Mining
» Data Mining for process improvement, Data Mining as a research tool



» Data Mining for marketing, Data Mining for customer relationship

management
5. Association Rules
» Introduction and overview, Discovering Association Rules
» A priori algorithm, Partition algorithm, Incremental algorithm
» Border algorithm, Association rules with item constraints
6. Classification and Clustering
» |Introduction, Clustering Paradigms, Partitioning Algorithm
» K-means clustering algorithm, Hierarchical clustering
» Fuzzy c-means algorithm, Categorical clustering Algorithm
7. Data Mining Tools
» Decision Trees
=+  Neural Networks
» Genetic Algorithms
» Rough Sets and Fuzzy Logic
8. Advanced Mining Techniques
» Web mining (Web content mining, Web usage Mining, Web structure
mining) and mining for e-business, text mining etc.
9. DW and DM Applications
=+ Business Intelligence, Customer Relationship Management with case
studies.
V.8 DBMS WITH ORACLE
Objectives
@ To familiarise the students with major DBMS concepts
& To emphasise effective ways of building a model of the real world and optimising
it through normalisation algorithms
& To acquaint the students with major features of ORACLE as a DBMS software
.

To create an understanding of the user-views of the real world and how such
views are organised through ORACLE

Because of its dual role as a tool for modelling information systems and a software
for maintaining the model of the system, the study of DBMS is now of fundamental



importance in the field of computer science and management information system.
The course addresses the twin goals of creating an optimal database design and
demonstrating the use of ORACLE as the main data manipulation software.

Topics

1. Database Design
» Basic Concepts
=+ Relational Data Model
» Relational Algebra
» Problems of an Ad-hoc Design
» Functional Dependencies
» Decomposition of a Relation Scheme
»  Normalisation
» Creating an Optimal Design
»  Multi-valued Dependencies
»  Fourth Normal Form

2. Database Manipulation
» Introduction to ORACLE
» Creating a Database Schema
» Changing a Database Schema
» Insertion, Deletion, Updation
» Simple Retrieval
» Complex Retrieval
»  ORACLE Forms
» Default Forms
» User-designed Forms
» PL - SQL Engine in Forms
» Interacting Forms
» QOracle Project Presentation



V.9 DECISION SUPPORT SYSTEMS

Objectives

Every day managers must make countless decisions that affect them, their work
groups, and the organization as a whole. Making decisions are often the most difficult
part of a manageris responsibilities. This course deals with concepts, methods,
applications of decision modeling to address various business issues. The basic
objective of this course is to provide with an understanding of the key technical and
managerial issues in the effective development and use of decision support systems
in organizations. While highly effective decision support systems using traditional
approaches and tools will be discussed, the focus of this course will be advanced
techniques and tools to support decision making process.

Topics
1. Managerial decision making and information systems.

» Requirement for decision support for decision making and other
executive work

» Human decision making heuristics and bounded rationality
» Types of Decision Support Systems

2. Decision support systems
»+ |ntroduction and overview
»  From human decision making to DSS
» DSS architecture
» Decision modeling and analysis
» Decision Support Developments
» Executive Information Systems
» Data warehousing, access, analysis, mining and visualization

3. Group Decision Support Systems
» Goals of Group Decision Support Systems
»  Group versus individual activities
»  Types of Group DSS
» Negotiation Support Systems

4. Intelligent Decision support systems
»  Knowledge-based decision support systems
» Knowledge acquisition and validation
» Knowledge representation
» |nference techniques

<D,



5. Decision Making Under Uncertainty
»+ |ntroduction and overview
» Understanding risk in making decisions
» Managerial risk taking and organizational decision making
» Modeling uncertainty
6. Advanced Techniques
=+  Neural Network fundamentals
=+ Neural Network Architecture
» Simple Neural Network applications
» Genetic Algorithm
» Fuzzy Logic
» Fuzzy Sets in decision making
» Intelligent software agents and creativity
» System integration and future of DSS.
V.10 e-BUSINESS
Objectives

This course will provide the students with an analytical and technical framework to
understand the emerging world of e-Business. e-Business poses both a challenge
and an opportunity for managers. As a matter of competitive necessity, savvy
managers must gain an understanding of the rapidly changing technology and
business models. They need to develop a basic understanding of how electronic
business differs from "real" business settings. They also need to acquire a hands-
on knowledge of the underlying technological infrastructure in order to have a clear
idea of the business and organizational possibilities inherent in these developments.
This course will attempt to fill this need. At the end of this course, the student will
be capable of :

&

&

Evaluating the opportunities and risk factors involved in conducting e-Business.

Identifying organizational processes and relationship that may have value added
through the application of an e-business strategy.

Assisting in the incorporation of an e-business strategy into the organization's
goals and objectives.

Understanding the current state of e-business and the possible advantages and
disadvantages of an e-business strategy.

Aiding in the development of managerial e-business tactics and objectives for
the organization's supply chain management functions.

D,



@ Exploring and explaining the legal and international implications of conducting
e-Business.

@ Analyzing and evaluating how the Internet, e-business technologies, and
e-business concepts can assist an organization realize its goals and objectives.

Topics

Introduction, background and current status

e-Business Architecture

Enabling technologies

e-Business Infrastructure

e-Business Design, Capacity Planning, Performance Modeling
e-Business Models

e-Marketing, e-CRM

e-Business Security/Payment services
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e-SCM, e-Procurement

=
o

. Knowledge Management

=
=

. ERP, e-Business backbone

=
N

. e-Business strategy into action, Challenges, e-Transition and Summary

H
N

. Business Plan Presentation and Demonstration "Materializing e-Business : From
idea to realization".

V.11 ENTERPRISE RESOURCE PLANNING

Objectives

The course aims to provide an understanding of the issues involved in design and
implementation of ERP systems. It focuses on the cross-functional processes and
integration of events/transactions across different functional areas in
organizations. On completion of the course, it is expected that the student would
be able to demonstrate :

< An understanding of the architecture of the ERP systems.

@ The understanding of ERP models and information flows underlying the ERP

softwares.



<« How integration works in an enterprise system, and the linkages with
organizational processes.

@ The basic principles and issues behind the ERP system design and
configuration.

@ Understanding of issues involved in ERP implementation.
Topics

1. Introduction to ERP Systems

2. Review of DBMS and Transaction processing concepts

3. Business Processes and integration across functions
4

MRP Il model and organizational processes :
» Sales and Distribution
»  Procurement
» Production Planning
»  Order fulfillment

5. Financial Model :
» Financial Accounting
» Controlling

6. the Information Model :
» |ntroduction to business information flows
» Introduction to business work flows

7. Issues in customizing ERP systems for organizations

8. Top Management concerns and ERP systems

9. Introduction to Extended ERP (ERP Il)/Advanced Planning Systems
10. ERP implementation.

11. Issues in utilization enhancement.



V.12 HUMAN RESOURCE INFORMATION SYSTEMS

Objectives

Today it is self-evident that information technology is fundamental to the practice
of general management. The Human Resource Information Systems elective is
designed to improve student's understanding of this technology, the people who work
with it, and its role in organizational performance. With the advent of this technology,
comes a need for its use in the human resources function, which this course
particularly focuses on.

Information technology spans all business functions. From their genesis as
automated accounting systems, information systems have evolved to become the
core of (and sometimes the impediment to) many organizations' competitive
strategies. The course is designed to investigate both the challenges and the
opportunities that are the result of this pervasiveness. It is intended to improve
fluency with and comfort in addressing the issues relating to the management of
information technology in the human resources function facing most organizations
today. In particular, the course aims to:

@ create awareness in upcoming managers, of different types of information
systems in an organisation so as to enable the use of computer resources
efficiently, for effective decision making.

@ understand various Management Information Systems operating in an
organisation particularly in the Human Resources Management functional area
and explain its relationship with the various other activities of the organisation.

< understand how Human Resources Information Systems are bought/developed
and implemented for various levels in an organisation.

@ explore the use of some common Information Systems development tools.
Topics

1. Computers and Computer Based Information Systems / Introduction to Computer
Based Information Systems -TPS/MIS/EIS/ES/DSS/0A

Management Concepts and CBIS / Case Study
Management Information Systems
Functional Applications / Exercise

HRIS Life Cycle/HR responsibility in each phase of HRIS development

o g M W N

Pre implementation stage of HRIS:
» HRIS planning
» HRIS expectation

D,



»  Productivity through HRIS

» HRIS cost-benefit value analysis

»  Getting Management support for HRIS
» Limitations of computerisation of HRIS

7. Implementation of HRIS:
» Tools in HRIS development
»+ Cases and Exercises
8. Human Resources Information Systems in large & small organisations: Cases
and Exercises
9. Packaged Human Resources Information Systems / Business Process
Re-engineering, Enterprise Resource Planning Systems
10. Emerging Trends in HRIS, Networking, Internet, Intranet, Technology
Implications, etc.
V.13 INFORMATION SECURITY AND RISK
MANAGEMENT
Objectives

Enhancing understanding of the :

& Types of risk and types of controls available to counter them
@ Cryptology and encryption theory and practice

& Key elements of a Risk Management program

@ Technical controls for risks in networks and e-mail

@ Legal, moral and ethical concerns in Risk Management
Topics

1. Aspects of Security

» Information Age and Risks

=+  Vulnerabilities

»+ Causes and Effects

» Communications Security Criteria
» Requirement Specification

» System Design



>+

»+

Physical Security
Organizational Integrity

2. Risk Management

»+

>+

>+

»+

»+

Grade of Risk

Level of Threat

Constraints

Balancing Risks and Countermeasures
Standards

3. Encryption Principles

»+

>+

»+

Theory and Terminology
Public Key Systems
Massage Authentication
Underlying Mathematics
Data Encryption Algorithm
Public Key Algorithms
Current Developments

4. Keys and Key management

»+

>+

»+

»+

Algorithm and Keys
Types of Keys
w  Secret Key
w  Public Key
w Hashing
w Digital Signature
Key Management
Digital signature and One Way Hash Functions

5. Technical Controls

»+

>+

>+

Access Control

File Protection

Virus Protection

Operating Systems

Databases and DBMSs

Security Protocols

Identification and Authentication
Network Security

<D,



7.

» Email Security
» Intrusion Detection
»  Audit Trails and Audit Reduction

Application Specific Risks
» Real-Time Control Systems
» Banking and Financial Transactions
» Legal and Contract Data
» Intellectual Property
=+ Personal Data
» National Security

V.14 |. S. STRATEGY

Objectives

The objective of this course is to arm the students, from both Business and
Technology sides, with the knowledge to create substantial shareholder value by
creating a well thought out and clearly articulated IS Strategy i.e. aligning IT
capability with business strategy.

This course introduces a business focused and quantitative approach and framework
to IS Strategy. It helps you understand:

@ The ibig picturel of IS Capability - where does IS Strategy fit in?

@ |S Strategy - what is it and how is it created?

< How to assess current alignment, identify and prioritize initiatives to achieve
alignment and monitor and control value creation?

< How to work collaboratively between business and IT?

Topics

1. Introduction: Forces that shape business strategy, Analyzing the impact of IT
on Strategic decision making

» |T Evolution and its implications for business (BusinessdlT Alignment)
2. IT Productivity Paradox

» Factors Contributing to the IT Productivity Paradox. Does the Paradox
Still Exist? Moving Beyond the Paradox.



3. Building the Networked Economy
=+ Value Chain and value Creation: The notion of value and value creation
is examined in relation to value chains and business processes.
4. Reasons for success and failure of IT projects
5. A Portfolio Approach to IS Development
6. Process Perspective of Valuation: To mix process and variance approach or not.
Is it another management buzz phrase?
» Advantages of Variance and Process Approaches. Combining Process and
Variance Approaches.
7. Valuation of IT Impact i APV method vis-a vis other methods
8. Technology Justification Models:
» The Real Options Approach. Economic Value Added. Statistical
Approaches.
9. Managing IT Infrastructure - IT Infrastructure and Strategic Alignment,
Strategies for Managing Diverse IT Infrastructures
10. Managing IT Outsourcing: Strategies for managing outsourced operations
11. Challenges and Opportunities in Assessing IT Payoff: Enterprise Resource
Planning Systems
12. Strategic impact of IT on Entertainment Industry:
» Strategic Dissonance, Burgelman and Grove, California Management
Review, Winter, 1996.
13. Strategic impact of IT on Financial Services:
V.15 OBJECT-ORIENTED PROGRAMMING
Objectives
& Object Oriented Programming is the most dramatic innovation in software
development in the last decade. Because of their inherent complexity,
programmes are prone to expensive error. OOP offers a new and powerful way to
cope with this complexity.
& The fundamental idea behind object oriented languages is to combine into a

single unit both data and the functions that operate on that data. Such a unitis
called an object.



@ An object's functions typically provide the only way to access its data. The data
is hidden, so it is safe from accidental alteration. Data encapsulation and data
hiding are key terms in the description of objected oriented languages.

< |f one wants to modify the data in an object, one knows exactly what functions
interact with it: the member functions in the object. No other functions can
access the data. This simplifies writing, debugging and maintaining the
programme.

@ One of the benefit of objects is that they give the programmer convenient way to
construct new data types. We can also use conventional operators in diverse
ways. This is known as polymorphism.

@ QOP presents new concepts and new tools for implementing them. Some of the
key concepts are operator overloading and inheritance. One of the main features
of this course will be to develop object oriented databases.

@ The course will be taught using Turbo C++.

Topics

1. Basics

2. Loops and Decisions

3. Structures

4. Functions

5. Objects and Classes

6. Arrays

7. Polymorphism and Overloading

8. Inheritance

9. Graphics

10. Animation

11. Pointers

12. Virtual functions

13. Object oriented databases

14. Programming of intelligent games



Objectives

V.16 SOFTWARE PROJECT MANAGEMENT

Over the years several systematic techniques have evolved for software development.
These techniques are used now in almost all-modern software development efforts.
These techniques provide systematic ways of doing requirements specification,
design, coding, testing maintenance, and project management.

Expose the students to systematic software development techniques.

The students at the end of the course be able to specify, and decompose large
problems into smaller logically coherent pieces.

The students would be familiar with structured analysis and design, and object-
oriented design

The students can systematically design test cases.

The students would be exposed to modern concepts in software quality and
reliability.

The students would be exposed to software project management techniques.

Introduction

to define software development and explain why it is important.

introduce concept of a software product and the attributes of well-
engineered software.

to describe the basic activities of the software development processes.
a generic view of software development.

Programming Paradigms

-

-

-

-

-

-

Topics

1.
>+
»+
>+
»+

2.
>+
»+
>+
»+
>+
>+
»+

3.

Programming in the large

The role of programming languages

The programming language design principles
Object-oriented programming

Concurrent programming

Functional programming

Logic programming

Life Cycle Models

>+

overview of different types of processes and life cycle models including
the waterfall - model, the v-model, the spiral model and various
prototyping models.



»+

modeling techniques and tools

4. Project Management

>+

»+

»+

project planning and scheduling

illustration of the use of graphical representations (activity charts and
bar charts)

work break-down structure, risk management, cost and cost estimation

5. Requirements Analysis and Specification

»+

>+

»+

>+

functional and non-functional requirements
ways to describe different kinds of requirements and how to prototype them
formal methods to be used in specifying and evaluating requirements

requirement documentation, requirement reviews, requirement quality
and how to measure it, requirements testability and selection of a
specific method

6. Software Design Fundamentals

>+

>+

>+

»+

»+

framework for software architecture
difference between conceptual and technical design
two basic approaches to design : composition and decomposition

characteristics of a good design, design strategies, system design
techniques

design quality

7. Function-Oriented Design

>+

>+

»+

»+

s/w design as a set of functions sharing system state information
notations to represent function-oriented design

process of function-oriented design

sequential and concurrent function-oriented design

8. Object-Oriented Design

>+

»+

»+

»+

s/w design as a set of interacting objects which manage their own state
and encapsulate state operations

process of OO design
models used to describe OO design
implementation of objects as concurrent processes

9. Coding and Unit Testing

»+

»+

»+

coding standard and procedures
coding guidelines and documentation
testing a variety of systems



>+

>+

unit test considerations
unit test procedures

10. Integration and System Testing

»+

integration testing
w top down integration
w bottom up integration
w  regression testing
w integration test documentation

» systems testing

w  recovery testing

w  Security testing

w  stress testing

w performance testing

11. Software Quality Assurance

»+

»+

»+

quality factors
procedures and standards leading to high quality software
tools for quality assurance

12. Software Reliability

»+

»+

»+

notion of software reliability and problem of reliability specification and
measurement

metrics used to quantify reliability

expressing reliability of different parts of a large software system in
different ways

process of statistical testing for reliability assessment
software safety and hazard analysis

13. Software Maintenance

>+

»+

»+

»+

corrective maintenance
adaptive maintenance
effective maintenance
preventive maintenance

14. Software Reuse

»+

»+

advantages/disadvantages of reusing software components

process involved in software development with use and software
development for reuse



» characteristics of reusable software components
» generic reusable components

» domain engineering
w IS how to build reusable components
w is classifying and retrieving reusable components

15. Client-Server Development
» structure of client-server systems
» software components for c/s systems
» distributions of software components and their linking

» analysis, modeling and design issues



VI. MARKETING

V1.1 MARKETING - |

Objectives

&

&

To understand and appreciate the concept of marketing in theory and practice

To evaluate the environment of marketing and develop a feasible marketing
plan (process)

To understand and apply the STP of marketing (segmentation, targeting,
positioning)

To have an elementary knowledge of consumer behaviour and marketing
research

To understand and appreciate the concept of marketing strategy formulation
and implementation

Topics
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Introduction to Marketing
Marketing Process
Marketing Environment
Segmentation

Targeting, Positioning
Consumer Behaviour
Marketing Research
Demand forecasting

Competition

10. Marketing Strategy

11. Customer Satisfaction



V1.2 MARKETING - Il

Objectives

@ Planning, designing and implementing marketing strategy to achieve the long-
term objectives have been critical for any firm in a competitive market situation.
This course seeks to develop the diffrent analytical perspectives, management
decision tools.

Topics

Introduction

Developing new market offerings
Product Life Cycle

Designing global market offerings
Product and Branding strategy
Project Proposal Presentation
Designing and managing services

Developing pricing strategy
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Advertising Strategy

=
o

. Media Planning

=
=

. Marketing Channels

=
N

. Retailing

=
w

. Marketing Communication

'_\
N

. Advertising

=
()]

. Managing sales force

=
(&)

. Industrial Marketing

=
~

. Total Marketing Effort



V1.3 BUSINESS-TO-BUSINESS MARKETING

Objectives

@ To prepare for a career in iBusiness to Business Marketingi

& To expose the students to a variety of product-market situations in the Indian
context

< To share the development in the area of Relationship Marketing (RM)

@ To share the concepts and frameworks which may be more relevant in industrial
marketing situations

@ To develop skills to formulate implementable marketing strategies

Topics

1. Organizational Buying Behaviour

2. Market Segmentation Strategy

3. Product Decisions (Matured Markets)

4. Management of New Industrial Products: Mapping the Entry Barriers

5. Pricing

6. Communication for Industrial Markets

» Communication Objectives, Tasks & Policies

7. Industrial Selling : The Indian Ground Realities

8. Relationships in Marketing : Its Many Facets

9. Channel Partnership

10. Relationship Marketing : Supplier Partnership

11. Customer Expectations and RM validity and Value for Money

12. Customer Satisfaction and Customer Relationship Management



V1.4 COMPETITION AND GLOBALIZATION

Objectives

The primary objectives of this course are to :

&

Equip the students with several viewpoints, concepts and frameworks to study
competition and globalization.

Provide an opportunity to study in depth the global competitiveness of Indian
firms.

Study globalization attempts of countries and lessons for India.

Topics
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Competition : Some Viewpoints

Porter's Framework on Competition

C K Prahalad's and Gary Hamel's Views

Sheth and Sisodia's Views

Rethinking New Perspectives

Perspectives on Globalisation

Globalization : The MNC and TNC Organizations
Globalization of Brands

Globalization of the Indian Business and Firms

10. Coping with Global Competition

V1.5 CONSUMER BEHAVIOUR

Objectives

At the end of the course it is expected that the students will be :

&

&

proficient and knowledgeable about the various disciplines contribution in
understanding buyer behaviour in a wholistic manner

familiar with the advances in consumer research in deciphering buyer
motivation, and behaviour (pre-purchase, purchase and post purchase), impact
of social and cultural variables on consumption decisions

equipped with frameworks to analyze consumers behaviour and use them in
designing marketing strategies and in enhancing the effectiveness of marketing
programmes



Topics

1. Consumer Behaviour - An Introduction, Key Foundations

2. Key Determinats of Buyer Behaviour and a Framework of Buyer Behaviour

3. Family Influences on Buyer Behaviour

4. Reference Groups, Opinion Leaders and Social Influences

5. Social Classes, Social Stratification and Buying Behaviour

6. Cultural Influences on Consumer Behaviour

7. Individual Determinants of Buyer Behaviour and Internal Processes
Understanding Consumer Motivation

8. Consumer Personality and Self Concept

9. Learning, Memory and Behaviour Modification

10. Formation and Modification of Consumer Attitudes

11. Consumer Decision Process - Prepurchase Issues

12. Purchase and Post Purchase Behaviour, Consumer Dissonance

13. Situational Determinants of Buyer Behaviour

14. Individual Adoption and Resistance Behaviour

15. Consumer Behaviour and Public Policy

V1.6 INTEGRATED MARKETING COMMUNICATIONS

Objectives

@ To provide an appreciation of the range of tools available for marketing
communications.

< To provide an understanding of the basic principles of planning and execution
in Marketing Communications.

-

Note : This course does not teach or measure creative work, like art, layout or copy

To develop a managerial perspective and an informed decision-marking ability

for effective and efficient tackling of promotional situations.

writing.



Topics

1. The crisis of Advertising
2. Marketing and the Communications Mix
3. The Decision of Buy
4. The Brand System
5. Planning Communications
6. The message, the target and the media
7. Research in Marketing Communications
8. Cultural and Ethical Concerns in Advertising
V1.7 INTERNATIONAL MARKETING
Objectives

< The course participants will become more familiar with the nature and
practices of international marketing. They should feel equally confident to be
able to distinguish international marketing mechanics from the domestic
marketing models and approaches.

< They would be far more equipped to design and participate in designing an
international marketing strategy.

& The spin-off benefits to the participants should be to develop in them a right
attitude, inject enthusiasm and hone their interactive ability as they address
the issues and challenges of operating in the international markets.

Topics
1. Introduction to International Marketing
» |nternational Marketing Environment
» Preparing for international Marketing Strategies

2. International Marketing Mix
» International Research and Segmentation
» Developing Global Products and Pricing
» |nternational Promotion and Advertising
» International Distribution Systems



3. The Indian Export Scenario

>+

>+

>+

»+

»+

»+

The Export Import Scene in India

Import-Export Policy

Export Documentation

Export Procedure

International Technology Transfer and Counter Trade
The Trade Mark Regime

4. International Marketing Planning

>+

»+

Objectives

Managing Systems for International Marketing
Reflection and Evaluation of the Endeavours

V1.8 MARKETING DECISION MODELS

@ Explain how analytical techniques can help in enhancing marketing decision-
making in modern enterprises.

@ Formulate long term marketing strategy with sound analytical judgment.

& Expose students to numerous examples demonstrating the value of the
analytic approach to marketing decision-making.

Topics
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Response Modeling

Market Segmentation

Choice based segmentation

Positioning Analysis

Project Presentation : Research Framework
Strategic Marketing Decisions

Portfolio Analysis

New Product Design

Forecasting Sales of New Products

10. Advertising Decisions



11.
12.
13.
14.
15.
16.

Sales Force Decisions
Distribution Decisions
Princing Decisions
Promotion Decisions
Strategy Decisions

Organizational Buying Model

V1.9 MARKETING FAIR

Objectives

Over the years, the Marketing Fair has become one of the most recognisable
symbols of our institute. In its simplest form, the concept of marketing fair is
ifun and learni. The learning is serious but the challenge still is to provide delight
to the fair's visitors and a value to the client companies. The objective of the
course is to achieve this delicate balance.

Topics
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Problem Allocation

Research Design Presentation
Game Design Presentation
Fabrication Begins

Data Presentation

Report Submission

VI.10 MARKETING IN PRACTICE

Objectives

&

&

To provide the to-be managers in the marketing area a practical exposure

To ensure the illustration of application of marketing theories in practice

This would be achieved in two different ways.

&

&

Lectures by practitioners (executives from various fields of marketing)

Computer based Simulation game Markstrat 3.10



Topics

Segmentation, Targeting, Positioning

Brand awareness, Brand Management

Portfolio Management

Benchmarking, Responding to competition

Production decisions, Pricing decisions, Advertising decisions
Sales force management, Distribution decisions

Utility of Marketing research studies

Budget decisions

R & D, New product launch
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Development and execution of Marketing Plan

VI.11 MARKETING LAW

Objectives

The Law and our legal system have a pervasive impact on marketing activities.
Decisions of marketing executives frequently raise issues which should be carefully
evaluated as to their legal consequences before they are implemented. The failure
to appreciate these legal implications can lead to seriously damaging, if not
disastrous, results for a firm.

The approach of this course would be to address National Laws and court decisions
that relate to the four main areas of marketing study, the so-called i four Pis i of
marketing: product, price, place and promotion.

Topics
1. Legal Issues Relating to Product Quality and Material Movement
»+ Conditions and warranties
» Implied Conditions
» Rule of Caveat Emptor [ Buyer Beware ]
=+  Transfer of Title
» Nemo Dat Quod Non Habet
» Sea Transit : FOB, CIF, Ex. Ship
» Rights of Unpaid Seller



2+ Lien

» Stoppage in Transit
» Right to Resale

=+ Remedies

Rules Relating to Hire- Purchase
» Position of Parties to Hire Purchase
» Conditions and warranties
» Limitation on Hire Purchase Charges
» Passing of Property

Laws Relating to Common Carrier
»  Definition of Common Carrier
» Distinction between Common Carrier and Pvt. Carrier
» Liabilities of Common Carrier

Legal aspects of Delivering Goods for Carriage and Warehousing
» Rights of Warehouse
»+ Duties and Liabilities of Warehouse

Rights to do any Trade or Business
=+ Fundamental
» Legal
»+ Restrictions

Restraint of Trade
» Knock fi Out Agreement
» Trade Combination
» Solus or Exclusive Dealing Agreements
» Restraints upon Employees

Law Relating to Services Marketing
» Concept of Service
» Deficiency in Service
» Real Estates
»  Hospital
» Carrier
» Courier



>+

>+

Bank
Transport Service

8. Legal Aspects of Restrictive Trade Practices

»+

»+

»+

»+

>+

>+

Tie-in Sales or Full Line Forcing
Price Fixing

Predatory Pricing

Exclusive Dealing

Territorial Restriction

Refuse to Deal

9. Legal Aspects of Unfair Trade Practices and some aspects of Advertisement

»+

»+

»+

»+

»+

»+

False and Misleading Representation

Bait Advertising and Bargain Price

Offering Gifts and Prizes and Conducting Promotional Contests
Withholding Information about Final Results of scheme
Hoarding and Destruction of Goods

Spurious Goods

10. Competition Law

>+

»+

»+

Introduction

Meaning

Anti-competitive agreement

Anti-competitive agreement : Competition within India & Effects Doctrine
Anti-competitive agreement : Horizontal

Anti-competitive agreement : Fixing prices

Anti-competitive agreement : Vertical Agreements

Anti-competitive agreement : Limiting and Controlling Production &
Investment

Acquisition, Merger & Amalgamation

Anti-competitive agreement & WTO



VI.12 MARKETING RESEARCH

Objectives

The objective of the course would be to give the students an understanding of
marketing research from both user's (management) and doer's (the researchers)
perspective.

Topics

Introduction: A decision making perspective of Marketing Research
An Overview of the Marketing Research

Problem ldentification

Methodology

Qualitative Research

Factor Analysis

Multi Dimensional Scaling

Pre-processor to MDS
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Conjoint Analysis

=
o

. Discriminant Analysis

=
=

. Cluster Analysis

=
N

. Segmenting and Positioning

=
w

. New Product Development

H
N

. Pricing Research

=
a1

. Media Research

=
(&)

. Strategy Formulation

=
~

. Brand Value

=
o0}

. Selling the Idea of MR



VI.13 PRODUCT AND BRAND MANAGEMENT

Objectives

&

To help the students appreciate the relationship between Corporate Strategy
and Product and Brand Management

< To equip the students with the various dimensions of product management
such as product-line decisions, product platform and product life cycle

@ To provide a framework to understand the new product development process,
the organizational structures for new product development and product
management functions within an organization

@ To explore the various issues related to Brand Management and to enhance
the understanding and appreciation of this important intangible strategic
asset including brand associations, brand identity, brand architecture,
leveraging brand assets, brand portfolio management etc.

@ To develop familiarity and competence with the strategies and tactics
involved in building, leveraging and defending strong brands in different
sectors.

Topics

1. Product Management — An Introduction

2. Corporate Strategy and Product Policy

3. Productline Decisions

4. Product Life Cycle and Marketing Strategies

5. New Product Development and the Techniques of Idea Generation and Screening

6. Concept Development and Testing

7. Test Marketing

8. Launching and Tracking New Product Programmes

9. Organising for New Products

10. Introduction to Brand Management and Crafting of Brand Elements

11. Consumer Brand Knowledge

12. Brand ldentity, Personality and Brand Associations

13. Managing Brand Architecture and Brand Portfolios



14. Corporate Branding and Tools for Building Brand Equity

15. Leveraging Brand Equity

16. Measurement of Brand Equity

V1.14 RETAIL MANAGEMENT

Objectives

&

To identify and understand the significance of retailing in the current business
environment

% To develop guidelines to build a retailing business
@ To dentify the competition in the market and develop strategies for retailing
business accordingly
@ To identify significant characteristics of the end consumer, understand its
significance for the retailing business and develop strategies accordingly
< To identify the paradigm shifts in retailing business with increasing scope of
technology 7/ e-business and develop strategies accordingly.
Topics
1. Introduction to retailing, concept
» Nature, scope
» Retail institutions, types
» History (success failure stories)
» Retail organization structure
» Retail management process
» |ndian retailing scenario
2. Environment of retailing
» Customers
» Market / competitors
» |nternal strengths and weaknesses
» Channel behaviour
3. Retailing Strategy

» Differential advantage and strategic planning
» Financial strategy
»+ Human resource strategy
» Marketing strategy
w  pricing strategy



=

=

vendor relation and distribution strategy (conflict resolution,
logistics)

promotion strategy

location

layout / design

servicing the retail customer

Merchandise management
» Merchandise plan
» Merchandise buying and handling
» Category management
» Merchandise presentation

Merchandise support management
» Managing human resources
» Managing operations
» Managing retail research and information systems

» |ntegration and control (retail audit)
» Influence of changing environment on retailing

demographic changes
lifestyle changes
technology changes (e-business)

» Career in retailing

4,

5.

6. Conclusion
Objectives

VI.15 RURAL MARKETING

At the end of the course it is expected that the students will be

&

Able to understand the present level of penetration of products and services
in Rural Markets and its potential.

Familiar with the changing profile of the rural consumer and at its
consumption pattern.

Exposed to the innovative marketing strategies developed by Indian firms as
well as MNCs for the Rural Markets.

Comfortable in designing product, price, distribution and promotional
strategies for different classes of product targeted at Rural Consumers.



Topics

1.
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Rural Marketing

»+

Relevance and Importance in the Emerging Scenario

Rural Market Environment and The Structure of Indian Market

Problems in Rural Marketing

Understanding the Process or Diffusion and Opinion Leadership

Strategies for Rural Markets

Changing Profile of the Rural Consumer

Developing Product Strategies for Rural Markets

Pricing Strategies for Rural Markets

Developing Distribution Channels for Rural Markets

10. Media Planning for Rural Markets

&

VI1.16

Objectives

SALES AND DISTRIBUTION MANAGEMENT

To provide an understanding of the concepts, attitudes, techniques and
approaches required for effective decision making in the areas of Sales and
Distribution.

To pay special emphasis on the practising manager's problems and dilemmas.

To develop skills critical for generating, evaluating and selecting sales and
distribution strategies.

Topics

1. Distribution Management Module

>+

>+

>+

Sales and Distribution Management
Distribution Objective/Strategy

Interface between Salesforce and Channel
Channel Design

Implementing Channel Design

Managing the Channel Members

Channel Power and Conflict

Channel Evaluation



2. Sales Management Module
» Territory Allocation
» Managing Accounts
» Effective Selling
»+ Salesman Recruitment
» Compensation and Motivation of Sales Force
»  Supervisory Styles
» Sales Organization
»+ Evaluation and Control of Sales Personnel

VI.17 SERVICES MARKETING

Objectives

< Planning and implementing the marketing strategy for service products
requires a different sort of approach, which is different from the traditional
goods marketing. The objective of this course is to acquaint the students to
the uniqueness of the services characteristics and its marketing implications.
The intent of the course is to discuss, measure and analyze several facets in the
area of services marketing essential for the success of a service sector firm.

Topics

1. Service Marketing : Uniqueness and challenges
2. Service Marketing Strategies

3. Managing Demand for Services

4. Pricing of Services

5. Communication of Services

6. Delivering of Services

7. Service Quality

8. Customer Satisfaction and Delight

9. Service Profit Chain

10. Quality and Profitability
11. Return on Quality

12. Service Productivity



VI.18 STRATEGIC MARKETING

Objectives

Being a capstone course of the Marketing Module, some of the key objectives of this
course are :

< To help students sharpen their analytical abilities in integrating strategic
marketing decision in a comprehensive manner.

< To become familiar with the concepts and framework in marketing strategy,
strategic market planning, competition analysis and in creating competitive
advantage.

@ To relate marketing in the context of the whole organization with special
emphasis on strategic management.

Topics

1. Many Facets of Strategic Marketing

2. Strategic Marketing : Over all view

3. Product and Service Strategy and Management
4. Re Aligning Marketing Resources

5. Competitive Strategy

6. Trun Around Strategy

7. Opportunity Analysis & Market Targeting

8. Distribution Strategy

9. Innovative Strategies

10. Product & Service Strategy & Management
11. Growth Strategies

12. Strategic CRM : Facets and Pay offs



VII. ORGANIZATIONAL BEHAVIOUR

VII.1 OB -1 : INDIVIDUAL AND GROUP BEHAVIOUR
IN ORGANIZATION

Objectives

Upon completion of the course, the students should be able to have better
understanding and grasp of

@ The basic concepts and theories underlying individual behaviour besides
developing better insights into one's own self

< |Individual behaviour in groups, dynamics of groups and team building besides
developing a better awareness of how they can be better facilitators for
building effective teams as leaders themselves.

Topics

Introduction

Personality, Self-awareness
Perception and Attribution
Learning

Values and Attitudes

Motivation

Groups, Group Dynamics, Teams

Skills for Managing Teams - Communication, Conflict, Power & Influence.
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Leadership
10. Building Healthy Team Culture

VII.2 OB - Il : ORGANIZATIONAL STRUCTURE, DESIGN
AND CHANGE
Objective

< To develop an understanding of the nature, functioning and design of
organization as social collectivities.



@ To examine the reciprocal relationship between the organizational
characteristics (for example : structure, strategies, systems etc.) and
managerial behaviour.

@ To develop theoretical and practical insights and problem-solving capabilities
for effectively managing the organizational processes.

Topics

What is an Organization?
Determinants of Organizational Design
Parameters of Organizational Design
Organization and Environment
Organizational Strategy

Organization and Technology

Types of Organizational Structures

Power and Conflicts in Organizations
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Organizational Decision-Making and strategy-Formulation

=
o

. Organizational Culture

=
=

. Organizational Failure and Pathology

=
N

. Organizational Change and Development

=
w

. Organizational Learning and Transformation

'_\
N

. Do "Organizations" Have a Future?

VII.3 ASSERTIVENESS TRAINING

Objectives
< To stand up for one's own rights without anger, fear or guilt.
@ To deal more effectively with employers, employees and people in personal life.

% To gain self-confidence and healthy self-respect while retaining respect for
other's rights.



Topics

Benefits of Assertiveness : Personal Growth Lab

Concept of Assertiveness: Components of Assertive behaviour
Measuring Assertiveness

Assertiveness Goals

Rational-emotive Assertiveness Training

Handling Fear

Handling Anger

Handling Depression
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Developing Assertive Behaviour Skills

=
o

. How to Handle Put-downs

=
=

. Assertiveness on the Job

=
N

. Assertiveness in Interpersonal Relations

=
w

. Assertiveness in Everyday Commercial Situation

'_\
N

. Assertiveness and Others

Vil.4 BUILDING LEARNING ORGANIZATIONS

Objectives

@ To develop a comprehensive framework to understand knowledge as a
strategic edge in turbulent environment.

@ To gain insight into the organizational learning processes, how they can be
fostered and enhanced.

@ To appreciate the learning techniques necessary to facilitate building
corporate competency and knowledge-base.

Topics
1. Emerging Business Realities
2. Why Organizations need to Learn

3. Organizational Learning : A Capabilities-Based View



4. Learning Tools and Techniques

» Systems Thinking

» Benchmarking and Process Mapping
5. Knowledge-based Competition
6. Knowledge-Creation and Acquisition Processes
7. Measuring Learning : The Intellectual Capital
8. Architechting a Learning Organization

VII.5 CONSULTING TO MANAGEMENT

Objectives

The Course aims to:

@ Provide a full perspective on Management Consulting.
< Develop technigues and skills of a consultant.
@ Develop skills of handling a client

< Develop insight into some areas of consulting.
Topics

1. Introduction to Management Consulting

2. Stages in Consulting

3. Gaining Access to a Client

4. Preparing a Consulting Proposal

5. Contracting Overview and Meeting

6. Roles consultants Play

7. Entering the Client Firm

8. Diagnosis : Several Approaches

9. Diagnosis: Defining the Information Need

10. Presenting Diagnosis

11. Several Data Collection Techniques



12. Review

13. Analysing Resistance

14. Developing Recommendations and Planning Intervention

15. Presenting your Analysis and Managing Group Meeting

VII.6 2 CROSS-CULTURAL MANAGEMENT

Objectives
< Develop a cognitive framework to appreciate the impact of culture on managerial
behavior and business processes
< Develop behavioral and cognitive skills to operate in the cultures of key countries
@  Apply his Zher understanding of cultural nuances to managerial / leadership
effectiveness, interpersonal communication / negotiations, designing systems
and structures, HR practices, etc.
Topics
1. Understanding Culture
»+ |ntroduction
»  Key Concepts
» Determinants of Cultural lIdentity
2. Frameworks for Mapping the Culture
»+  Geert Hoefstede
» Clyde Cluckhohn
=  TE Hall
3. Studies of National Culture
4. Implications for Management Theory and Practice

»  Adjusting to the New Culture
» Cultural Relativity of Management Theory
» Competencies for Global Manager



VII.7 DESIGNING ORGANIZATIONS FOR

Objectives

UNCERTAIN ENVIRONMENT

This course aims to provide a comprehensive perspective on new emergent
organizational forms by discussing them in the perspective of environment,
strategy and systems & processes. Specifically, it will help the participants to :

@ Develop and acquire cognitive framework to understand and analyze the
hyper-turbulent business environment.

@ Gain insights into strategic models which successful organizations deploy to
develop their strategies.

< Learn designing principles to create organizations capable of performing in
uncertainty and hyper-turbulence.

@ Appreciate the HR/People systems and processes required for emergent
organizational forms.

Topics

1. Understanding Emerging Environment :

>+

»+

>+

>+

»+

»+

Emergence of Vortical/Type-5 environment

Understanding Hyper-turbulence

Networks & Business Eco-Systems

Role of Information Technology in Shaping Business Environment
Understanding Impact of Technological Discontinuities

Law of Increasing Returns in Networked, Knowledge-Based Economy

2. Changing Models of Strategy :

»+

>+

>+

>+

Strategy-Making under Uncertainty

Application of Complexity/Chaos Theory to Strategy
Strategy as "Sense-Making"

Shaping and Adapting to Networks

3. New Forms of Organization :

»+

»+

»+

Organizations as Networks

Types of Network Organizations/Clusters : Kingdom and the Republic
Self-Organising Systems

Organizational Designs for Change and Innovation

Designing Principle for New Forms of Organizations



4.

People and Process issues in Emerging Organizational Forms
» Systems for Team-Based Functioning
» High Performance Work Systems
» Managing Empowerment and Accountability
» Designing Roles and Systems for Flat, Networked Organizations
» Developing Competencies for New Organizational Forms

VII.8 IMPRESSION MANAGEMENT

Objectives

&

Be able to effectively and appropriately use a variety of tactics to manage the
impressions that others have of you.

Understand why people are motivated to manage othersi impressions of them,
and how this motivation varies across situations and persons.

Have the capacity to perceive clearly the effects of self-presentation in
organizations and the role played by the myriad of factors that moderate those
effects.

Topics
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8.
9.

An introduction to impression management; Impression formation.

Tactics.

The self-presentational motive.

The compass qualities; First and lasting impressions; Magic pills; Toxic traits.
The social context: Norms and roles.

The targetis values.

Physical appearance; Body language; Voice; Communication style; Content of
communication; Actions; The environment; Success; Changing from the outside-
in.

Current social image.

Instrumental complementarity.

10. The private self.

11. Worrying about impressions.



VII.9 INDIAN PHILOSOPHY AND LEADERSHIP
EXCELLENCE

Objectives

&

Understanding how the Indian worldview will affect your effectiveness as a
manager.

% Enhancing self-awareness by delving deeper into what constitutes your true
self, and hence making your life richer and less stressful.

@ Developing greater insights regarding your life goals and the means to achieve
those goals.

@ Being able to transform others by taking them closer to their real irootsi and
thereby enhance effectiveness.

Topics

1. The Vedas: General aspects; Life Goals 6 Dharma, Artha, Kama and Moksa.

2. Samhitas, Brahmanas, Aranyakas.

3. Upanisads: Brahman; Atman; Gross, subtle, and causal bodies; Panca Kosa (five
sheaths); Waking, dream, deep sleep, and Turiya (fourth) states; ldentity of
Brahman and Atman; Realization of Brahman; The Path to Realization; Sravana
(hearing), Manana (thinking), Nidhidhyasana (meditating); Karma and
Reincarnation; Immortality, Samskara (impression), and Law of Reincarnation.

4. The auxiliary scriptures: The Ramayana; The Mahabharata.

5. The Bhagavad-Gita: Jnana (knowledge) and Karma Samnyasa (renunciation);
Work and its secret.

6. The Smrtis, the Puranas, the Tantras.

7. Jainism and Buddhism.

8. The six systems of thought: Nyaya; Vaisesika; The Samkhya system 6 Three
Gunas (constituents); The Yoga System of Patanjali 6 The powers of the mind,
Dhyana (meditation); The Purva Mimamsa; The Uttara Mimamsa or the Vedanta
Sutras 6 Maya and illusion, Maya and freedom; Practical Vedanta.

9. Saints and thinkers: Gaudapada; Samkara; Bhaskara; Yamuna; Ramanuja;

Nimbarka; Madhwa; Vallabha; Caitanya; Ramakrishna.



VII.10 LEADERSHIP, INFLUENCE AND POWER

Objectives

This course provides an in-depth look at transformational leadership 6 the mutually
stimulating relationship between leader and follower that raises both of them to higher
levels of human conduct and ethical aspiration. It will help, as a leader, to enhance
and effectively use power not only in achieving goals, but also in enabling followers
to lift themselves into their better selves. The course:

< Will give an understanding of how leadership, influence and power are related
various facets of organizational life at the individual, group and macro levels.

< Be able to enhance power in organizations, tap different sources of power, and
effectively use power to achieve objectives and to help elevate followers to high
levels of motivation and morality.

<  Will develop the capacity to perceive clearly the various tactics that others
use to influence in order to achieve their objectives.

Topics

Decisions and Implementation

The structure of moral leadership

Diagonising Power and Dependence

Where does power come from?

Resources, allies, and the new golden rule
Location in the communication network
Formal authority, reputation, and performance

The importance of being in the right unit
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Individual attributes as sources of power

=
o

. Framing: How we look at things affects how they look

=
=

. Interpersonal influence

=
N

. Timing is (almost) everthing

=
w

. The politics of information and analysis

'_\
N

. Changing the structure to consolidate power

=
()]

. Symbolic action: language, ceremonies, and settings

@



16. Even the mighty fall: how power is lost?
17. Managing political dynamics productively
18. Toward a general theory

19. Managing with power

VIl.11 MANAGEMENT OF CREATIVITY

Objectives
The course aims to develop:

= An understanding of creative processes and creative problem solving
techniques;

@ Managerial/behavioural skills conducive to encouraging creative efforts in self
and others; and

< An insight into organizational systems and structures which facilitate
creativity and innovation.

Topics

Understanding Creativity

Unblocking Creative Potential

Creative Person and Process

Creative Style

Profiles of the Creative People

Divergent Thinking Skills and Creativity Techniques
Creativity in Organizations

Selling Creative ldeas
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Managing Creative Processes
10. Innovation, Research and Product Development
11. Organising for Creativity and Innovation

12. Innovation as Competitive Strategy

@



VII.12 MANAGEMENT OF RELATIONSHIPS

Objectives

As an application of the psychoanalytic explorations and principles of human
relationship, this course aims at:

& A deeper understanding of the psychological dynamics of human relationships,
as they are applicable to social and professional life; and
@ Helping participants establish effective and satisfactory relationships in
personal life and managerial practices.
Topics
1. Psychoanalysis of Human Relationships: Basic concepts
2. Psychoanalysis of Relationships within the Indian Context
3. Applications to the Organizational Relationships:
»  Oedipus in the office
» Leadership
» Subordinacy
» |Interpersonal Conflicts
4. Applications to Family Relations
» Partnership
» Parenting
» Emotional Spillover
»+ Deviant Relations
5. Psychoanalysis of Social Life in India

= Women in India
» Psychoanalysis and the Indian Culture

VI1.13 PERSONAL EFFECTIVENESS AND LEADERSHIP

Objectives

Pad

To identify the course participant's strengths and weaknesses as a person and
a member of a group or organization using personality typing.

To enhance one's own self awareness and to understand others utilising
methods from Neuro-Linguistic Programming (NLP).

@



»  To sensitise students to the emerging perspectives on spiritual foundations of
personal effectiveness and leadership.

Topics
Understanding your thinking process
Identifying the filers on your world
Enriched communication through sensory specific language

Managing your internal dialogue

1
2
3
4
5. Perceptual positions for assertiveness
6. Anchoring a resourceful stage for yourself to manage conflicts
7. Creating rapport

8. Powerful persuasion strategies

9. Personality typing using Enneagram

10. Introduction to Briggs-Myers Personality Types

11. NLP Test

12. Selling with NLP

13. Managing with the power of NLP
*  Life planning: Personal mission and vision

14. Principle Centered Leadership

15. Emotional Intelligence

16. The Road Less Travelled

17. The seven habits of highly effective people
18. Effective Life and Time Management

19. Spiritual foundations of personal effectiveness



Vil.14 PERSONAL GROWTH LAB

Objectives

@ To provide a conceptual framework for understanding human behaviour using
NLP.

@ To identify the student's strengths and weaknesses as a person and a member
of a group or organization using personality typing.

@ To explore feelings and behaviour using the TA model so as to discover the
inner springs of one's behaviour system.

Topics

Understanding thinking process using NLP

NLP basics

Enriched communication through sensory specific language
Life Positions

Ego states

Transactions

Games

Strokes and Stamps
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Time structuring
10. Scripts
11. Introduction to Enneagram

12. Personality types according to Enneagram



VII.15 STRESS MANAGEMENT

Objectives

&

To understand the nature of stress, and the relationship between stress and
managerial problems.

@ To examine the various methods of assessing personal and organizational
stress, and indicating ways of coping with stresses.

Topics

1. Nature of Stress 6 Constructs and Problems

2. Occupational Stressors

3. Role Stress

4. Sources of Managerial Stress

5. Stress and Thought Processes 6 Learning

6. Stress and Personality - Behavioural and Situational Modifiers

7. Stress and Motivation

8. Verbal and Non-verbal Indicators of Stress

9. Assessment of Stress

10. Stress and Management Change

11. Stress and Conflict

12. Leadership Styles in Stressful and Non-Stressful Situations

13. Decision Making under Stress

14. Burnout

15. Coping with Resources and Processes 0 Assertiveness Training

16. Stress and Social Support

17. Group Processes and Changing Values for Understanding and Coping with Stress



VII. 16 TRANSACTIONAL ANALYSIS

Objectives

&

&

&

To provide a theoretical framework for understanding human behaviour.
To explore one's own feelings and behaviour using the TA model.

To understand the application of TA in several areas of people management
organizations.

Topics

© © N o g c w N P

TA and Self Awareness
Concept of Script
Winners and Losers
Structural Analysis
Life Positions
Transactions

Games and Strokes
Life Scripts

TA Applications in Motivation, Leadership and Teamwork

10. TA in Counselling

11. Contracting for Change



VIIl. PRODUCTION & OPERATIONS

MANAGEMENT

VIII.1 OPERATIONS RESEARCH

Objectives

&

To provide a formal quantitative approach to problem solving and an intuition
about situations where such an approach is appropriate.

@ To introduce some widely-used mathematical models. The understanding of
these models will allow the students to communicate with persons who run
them and to evaluate the results they present.

< To provide a tool that the students can use to solve management problems.

Topics

1. Linear Programming Problems (LPP)

» An overview and scope of Operations Research
» |ntroduction to Linear Programming (LP)
=+ |llustration of LP Problems
=+  Formulation exercises on LP Problems
» Graphical Method of solving LPP
»  Simplex Method
» Unboundedness, Multiple Optimum Solutions, Degeneracy and Cycling
Problems
»  Artificial Variables : Big-M Method
»  Sensitivity Analysis
» Duality Problems
» Economic Interpretation of Simplex Tableau
» Computer Software for Solving LPP
2. Special Types of LPP
» Formulation of Transportation Problems
»  Sensitivity Analysis in Transportation Problems
»  Assignment Problems
3. Integer and Goal Programming Problems

» Formulation, Cutting Plane Method
» Branch and Bound Method



»  Applications
» Single and Multiple Goal Programming Problems

4. Markov Chains, Queueing Theory
» Concepts, Transition Probabilities
» Steady-State Probabilities
»  Applications

5. Dynamic Programming Problems

VIIl.2 PRODUCTION MANAGEMENT - |

Objectives

@ To get acquainted with the basic aspects of Production Management. The course
attempts to discuss various important planning, organizing and controlling
aspects of Operations Management. Through text and case studies, this course
prepares for a study of different operational issues in manufacturing and services
organizations.

Topics

1. History and Overview of Production Management

2. Capacity Planning

3. Location Planning

4. Types of Production Processes. Layout Planning

5. Productivity Management

6. Deterministic and Probabilistic Inventory Management models
7. Purchasing and Warehousing

8. Methods Study, Motion Study and Work Measurement

9. Job Evaluation

10. Wage Incentive Schemes

11. Value Analysis



VIII.3 PRODUCTION MANAGEMENT - Il

Objectives

@ The course is to reinforce the concepts of Production Management through
various operational aspects of Production Management. Various important
Production Management techniques will be covered with different problem-solving
methodologies. Case studies and assignments will further augment the
understanding of the subject.

Topics

1. Forecasting

2. Aggregate Planning

3. Scheduling: Gantt Charts and Sequencing

4. Project Management with PER/CPM

5

» Material Requirements Planning (MRP)
» Manufacturing Resources Planning (MRP II)
» Enterprise Resource Planning (ERP)

6. Total Quality Management
»  |1SO 9000 and ISO 14000 Quality Systems
» Statistical Process Control (SPC)

7. Maintenance Management:
» Reliability and Maintenance
» Replacement Techniques

8. Logistics and Supply Chain Management

VIIl.4 QUANTITATIVE TECHNIQUES - |

Objectives
The objectives of this course may be specified as follows:

< to provide a basic tool kit of relevant tools which would be necessary for decision-
making;

@ to develop students' diagnostic and analytic skills through suitable logical
problems to types;



@ to develop their ability to measure and judge quantities;

@ to provide a probabilistic base for all functional areas of management,
Topics

1. Theory of Probability
» What is probability?
» Experiment, sample space and events
» Equally likely outcomes
» Total and compound probability
» Conditional probability
» Law of independence
» Bayes' theorem
» Union of events
» Random variables
» Mathematical expectation and variance

2. Discrete Distributions
» Binomial distribution
»  Poisson distribution
» Negative binomial distribution
»  Hypergeometric distribution

3. Continuous Distributions
»  Normal distribution
» Exponential distribution

4. Decision Theory
» Decisions under uncertainty
» Sequential decision-making
» Bayesian posterior analysis
» Bayesian preposterior analysis

5. Sampling and Estimation
»  Simple random sampling
» Unbiased estimates



VIII.5 QUANTITATIVE TECHNIQUES - 11

Objectives

&

In this course our major emphasis will be on Statistical Inference. Statistical
analysis as a manufacturing process begins with raw materials, which are
numerical or categorical data, the finished products being whatever useful
information or valuable conclusions that lie buried among the crude data. No
matter how we decide problems arising in the day-do-day operation of a business,
in industrial or economic planning, in science, and in everyday life, we must
always face the risk of making a wrong choice. It is the task of statistics to
evaluate such risks and if possible, to provide criteria which minimize the chance
of making wrong decisions.

& Statistical inference is the process by which we draw a conclusion about some
measure of a population based on a sample value. The measure might be a
parameter, such as the average or mean amount of money that consumers plan
to spend on a new car, or an attribute, such as the percent of consumers favoring
foreign cars to indigenous ones. The purpose of sampling is to estimate these
characteristics for the population from which the sample is selected. Sample
information may be used for either of two purposes — reporting or decision-
making. Tests of hypothesis are the means of doing this and they will constitute
the major topic to be discussed. We will cover both parametric and non-parametric
inference in this regard.

Topics

1. Sampling

2. Estimation

3. Parametric Inference

4. ANOVA

5. x?-tests on goodness of fit and contingency tables

6. Non-parametric Inference

7. Regression Analysis & Tests on Correlation Coefficients

8. Design of Experiments



VIII.6 ADVANCED INVENTORY CONTROL

Objectives

To treat the subject in depth by emphasizing on the practical aspects and the latest
developments in the field.

Topics

Introduction to Scientific Inventory Management
Advanced Forecasting Methods

Static and Dynamic Inventory Control Models
Materials Requirement Planning (MRP)
Just-in-Time Inventory Systems

Multi-Echelon Inventory Systems

L T R

Simulated Inventory Systems

VIIl.7 ADVANCED OPERATIONS RESEARCH

Objectives

@ To create an awareness of the techniques available to analyse a dynamic
system and their application.

< To develop skills in solving managerial problems using these techniques.
Topics

1. Stochastic Processes
»  Applications in Marketing, Finance, Production and HR

Advanced Queuing Models
Non-Linear Programming

Quadratic, Convex and Stochastic Programming Problems

o > w D

Game Theory



VII1.8 e-BUSINESS

Objectives

This course will provide the students with an analytical and technical framework to
understand the emerging world of e-Business. e-Business poses both a challenge
and an opportunity for managers. As a matter of competitive necessity, savvy
managers must gain an understanding of the rapidly changing technology and
business models. They need to develop a basic understanding of how electronic
business differs from "real" business settings. They also need to acquire a hands-
on knowledge of the underlying technological infrastructure in order to have a clear
idea of the business and organizational possibilities inherent in these developments.
This course will attempt to fill this need. At the end of this course, the student will
be capable of :

< Evaluating the opportunities and risk factors involved in conducting e-Business.

< ldentifying organizational processes and relationship that may have value added
through the application of an e-business strategy.

@ Assisting in the incorporation of an e-business strategy into the organization's
goals and objectives.

< Understanding the current state of e-business and the possible advantages and
disadvantages of an e-business strategy.

@ Aiding in the development of managerial e-business tactics and objectives for
the organization's supply chain management functions.

< Exploring and explaining the legal and international implications of conducting
e-Business.

@ Analyzing and evaluating how the Internet, e-business technologies, and
e-business concepts can assist an organization realize its goals and objectives.

Topics

1. Introduction, background and current status

2. e-Business Architecture

3. Enabling technologies

4. e-Business Infrastructure

5. e-Business Design, Capacity Planning, Performance Modeling

6. e-Business Models

7. e-Marketing, e-CRM



8. e-Business Security/Payment services

9. e-SCM, e-Procurement

10. Knowledge Management

11. ERP, e-Business backbone

12. e-Business strategy into action, Challenges, e-Transition and Summary

14. Business Plan Presentation and Demonstration "Materializing e-Business : From
idea to realization".

VIII.O ENTERPRISE RESOURCE PLANNING

Objectives

The course aims to provide an understanding of the issues involved in design and
implementation of ERP systems. It focuses on the cross-functional processes and
integration of events/transactions across different functional areas in
organizations. On completion of the course, it is expected that the student would
be able to demonstrate :

< An understanding of the architecture of the ERP systems.

@ The understanding of ERP models and information flows underlying the ERP
softwares.

<« How integration works in an enterprise system, and the linkages with
organizational processes.

<« The basic principles and issues behind the ERP system design and
configuration.

@ Understanding of issues involved in ERP implementation.
Topics

1. Introduction to ERP Systems

2. Review of DBMS and Transaction processing concepts

3. Business Processes and integration across functions



4. MRP Il model and organizational processes :
» Sales and Distribution
»  Procurement
» Production Planning
»+  QOrder fulfillment

5. Financial Model :
» Financial Accounting
» Controlling

6. the Information Model :
» |ntroduction to business information flows
» |ntroduction to business work flows

7. Issues in customizing ERP systems for organizations

8. Top Management concerns and ERP systems

9. Introduction to Extended ERP (ERP Il)/Advanced Planning Systems
10. ERP implementation.

11. Issues in utilization enhancement.

VIII.10 LOGISTICS AND SUPPLY CHAIN
MANAGEMENT

Objectives

@ To give students an understanding that the problems and issues within the
respective fields of logistics are invariably complex, and require clear
reasoning and analysis, in order to derive an appropriate course of action.

@ To incorporate and learn the critical elements of Logistics and Supply Chain
Management processes

& To give students an appreciation that the process by which appropriate
decisions are made often requires not only technical competencies from those
individuals involved, but also requires them to possess competencies of a more
managerial nature; and vice versa.

@ To equip students with the required depth and balance of technical and
managerial competencies such that they will be able to function successfully
in their chosen field.



@ Qverall, to give a frame of reference for logistics and supply chain
management - to give knowledge of the functions of the logistics and supply
chain systems - to give knowledge of the relations of the logistics and supply
chain systems to its environment - to give knowledge of the management and
the operations.

Topics

1. Introduction to Logistics and Supply Chain Management

2. Supply Chain Drivers and Obstacles

3. Logistical Activities

4. Demand Management and Forecasting in a Supply Chain

5. Planning Supply and Demand in Logistics and Supply Chain Management
6. Warehousing Decisions and Facilities Location in a Supply Chain Network
7. Planning and Managing Inventory in a Supply Chain

8. Transportation, Network Design and Information Technology

9. Organization of the Supply Chain

»  Supply Chain synchronization
» Supply Chain Performance Measurements
»  Sourcing and Procurement

VII1.11  MATERIALS MANAGEMENT

Objectives

<  While the principal objective of this course is to familiarise the students with
various facets of materials management, the course has been designed in
such a manner so as to bring the students closer to the advanced and recent
techniques in materials management. It will develop the skills necessary in
the present dynamic environment. The course also aims to provide an
opportunity to understand the crucial importance of materials management
functions vis-a-vis other functional activities in any organization.

Topics
1. Introduction and Objectives

2. Materials Management concepts and their importance
» Integrated Materials Management, Profit Centre Concept

@



3. Purchasing Function
» Objectives, Scope and importance, Organization for Purchasing,
Centralisation vs. Decentralisation, Delegation of Powers, Purchasing
Cycle Elements and their importance, Purchase Policies and Procedures
4. 5Rs of Purchasing and Related issues
» Technical, Commercial and Legal aspects of Purchasing
5. Contracts Management
6. Make or Buy decisions
7. Import Policy and Procedures
» Capital Goods and Project Imports, Spares, Consumables and
Components, Specific Licensing Provisions
8. Project Buying and Related aspects
9. Vendor Rating and Source Location
10. Negotiations in Purchasing
11. Outsourcing Management
12. Stores Function
» Relevance and importance
»  Objectives
» Stores ldentification System and Codification
13. Stores Procedures and Organization
» |nspection and Handling, Storage Procedures, Security, Stores Issues
and Receipts
14. Inventory Valuation
VIIL.12 PRODUCTION PLANNING AND CONTROL
Objectives

< To acquaint the students with the advanced techniques for managing

operations. Various case studies further reinforce the concepts.

Topics

1. Applications of Production Planning Techniques

2. Operations Research Applied to Production Planning
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11.
12.
13.
14.

Objective

&

Computer Aided Facilities Layout

Optimised Production Technology

Group Technology

Computer Aided Process Planning

Advanced Inventory Models

FMS and Industrial Robotics

Enterprise Resource Planning

. Simulation Technique

Just-in-Time

Computer Integrated Manufacturing

Human Aspects in Production

PPC in Supply Chain Management

The course has been designed to create an awareness of the need for
systematic management of projects. This application-oriented course provides
the skill in executing various projects, starting from project identification till

VII1.13 PROJECT MANAGEMENT

project termination.

Topics

1. An Overview and Key Concepts of Project Management

2.

Project Feasibility Studies

>+

>+

>+

Project Identification

Market and Demand Analysis
Technical Analysis

Project Cost Estimate

Financial Appraisal of Single Projects
Financial Appraisal of Multiple Projects



3. Human Aspects in Project Management
» Project Organization
» Project Leadership
» Motivation in Project Management
» Communication in the Project Environment
» Conflict in Project Management
4. Project Scheduling with PERT/CPM
5. Time-Cost Trade-Off and Crashing of Projects
6. Application of Project Management Softwares
7. Contract Management
8. Project Cost Control (PERT/Cost)
9. Resource Scheduling and Resource Levelling
10. Risk Analysis in Project Management
11. Project Audit and Project Termination
12. Project Control
13. Case Studies on Project Management
VIIl.14 TECHNOLOGY MANAGEMENT
Objectives
& The course focuses on different matters of importance related to Technology
Management. It discusses various aspects of technological innovation and
subsequent diffusion. It also analyses the Technology Management scenario
in India.
Topics
1. Evolution of Technology; Effects of New Technology
2. Technology Innovation

»  |nvention-lnnovation-Diffusion
» Revolutionary and Evolutionary Innovation
»  Product and Process Innovation



10.

11.

12.
13.

Strategic Implications of Technology
» Technology - Strategy Alliance
» Convergent and Divergent Cycle
» The Balanced Approach

Technology Assessment
» Technology Choice
» Technological Leadership and Followership
» Technology Acquisition

Technological Forecasting

» Exploratory : Intuitive, Extrapolation, Growth Curves, Technology
Monitoring

» Normative: Relevance Tree, Morphological Analysis, Mission Flow
Diagram
Diffusion of Technology
»+ Rate of Diffusion; Innovation Time and Innovation Cost
» Speed of Diffusion

Technology Indicators
»  Various Indicators

Organizational Implications of Technology

» Relationship between Technical Structure and Organizational
Infrastructure

» Flexible Manufacturing Management System (FMMS)

Financial Aspects in Technology Management
» |mproving Traditional Cost Management System
» Barriers to the Evaluation of New Technology

Social Issues in Technology Management
» Technological Change and Industrial Relations
» Technology Assessment and Environmental Impact Analysis

Human Aspects in Technology Management
» |ntegration of People and Technology
» QOrganizational and Psychological Factors
» Organizational Outcome

Technology Transfer

Technology Management Scenario in India

@D



VIIT.15 TOTAL QUALITY MANAGEMENT

Objectives

@ To introduce the students to the basic concepts of total quality management and

how the focus of TQM has become so important for all companies in recent times.

Topics

1.

9.
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Meaning of "Quality" - Orientation to Customer Satisfaction and Scope of
TQM or TQC

Basics and Imperatives of TQM

Cost of Quality and its relevance to TQM

Concept of Kaizen and Continuous Improvement

Issues on Quality by Demming, Crosby, Taguchi, Juran and Other Experts
Introduction to Quality Management System and I1SO-9000

Clauses of ISO 9000

Process Improvement

»  Problem Solving, Juran's Approach, Project by Project Quality
Improvement, Introduction to SPC

Quality Improvement Tools and Exercises

10. Peoples Issues in TQM

» Leadership Issues, Total Employee Involvement, 5S Concept

11. Quality Circles and its relevance



IX. STRATEGIC MANAGEMENT

IX.1 STRATEGIC MANAGEMENT

Objectives

&

To expose participants to various perspectives and concepts in the field of
Strategic Management.

@ To help participants achieve conceptual clarity.
< To help participants develop skills for applying these concepts to the solution
of business problems.
Topics
1. Introduction to Strategic Management
» The Importance of Strategic Management
» Schools of thought in Strategic Management
» Strategy Content, Process and Roles
» The Fit Concept and the Configurational Perspective in Strategic
Management
» Dimensions and Levels of Strategy
2. Competitive Strategy
» Five Forces that Shape Strategy
» Generic Strategies
» Generic Strategies and the Value Chain
3. Corporate Strategy
»+ The Motive for Diversification
» Related and Unrelated Diversification
» Business Portfolio Analysis
4. Strategy Implementation: Structure, Systems and People
»+ The 7S Framework
5. Recent Advances

» Core competence as the root of competitive advantage
» Business processes and capabilities-based approach to strategy

@D



1X.2 BUILDING LEARNING ORGANIZATIONS

Objectives

&

To develop a comprehensive framework to understand knowledge as a
strategic edge in turbulent environment.

@ To gain insight into the organizational learning processes, how they can be
fostered and enhanced.
@ To appreciate the learning techniques necessary to facilitate building
corporate competency and knowledge-base.
Topics
1. Emerging Business Realities
2. Why Organizations need to Learn
3. Organizational Learning : A Capabilities-Based View
4. Learning Tools and Techniques
» Systems Thinking
» Benchmarking and Process Mapping
5. Knowledge-based Competition
6. Knowledge-Creation and Acquisition Processes
7. Measuring Learning : The Intellectual Capital
8. Architechting a Learning Organization
IX.3 COMPETITION AND GLOBALIZATION
Objectives

The primary objectives of this course are to :

&

Equip the students with several viewpoints, concepts and frameworks to study
competition and globalization.

Provide an opportunity to study in depth the global competitiveness of Indian
firms.

Study globalization attempts of countries and lessons for India.



Topics

Competition : Some Viewpoints

Porter's Framework on Competition

C K Prahalad's and Gary Hamel's Views

Sheth and Sisodia's Views

Rethinking New Perspectives

Perspectives on Globalisation

Globalization : The MNC and TNC Organizations

Globalization of Brands
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Globalization of the Indian Business and Firms

10. Coping with Global Competition.

IX.4 DESIGNING ORGANIZATIONS FOR UNCERTAIN
ENVIRONMENT

Objectives

This course aims to provide a comprehensive perspective on new emergent
organizational forms by discussing them in the perspective of environment,
strategy and systems & processes. Specifically, it will help the participants to :

@ Develop and acquire cognitive framework to understand and analyze the
hyper-turbulent business environment.

@ Gain insights into strategic models which successful organizations deploy to
develop their strategies.

< Learn designing principles to create organizations capable of performing in
uncertainty and hyper-turbulence.

& Appreciate the HR/People systems and processes required for emergent
organizational forms.
Topics
1. Understanding Emerging Environment :
» Emergence of Vortical/Type-5 environment

» Understanding Hyper-turbulence
» Networks & Business Eco-Systems

@,



>+

»+

»+

Role of Information Technology in Shaping Business Environment
Understanding Impact of Technological Discontinuities
Law of Increasing Returns in Networked, Knowledge-Based Economy

2. Changing Models of Strategy :

>+

>+

>+

>+

Strategy-Making under Uncertainty

Application of Complexity/Chaos Theory to Strategy
Strategy as "Sense-Making"

Shaping and Adapting to Networks

3. New Forms of Organization :

»+

»+

»+

»+

»+

Organizations as Networks

Types of Network Organizations/Clusters : Kingdom and the Republic
Self-Organising Systems

Organizational Designs for Change and Innovation

Designing Principle for New Forms of Organizations

4. People and Process issues in Emerging Organizational Forms

>+
>+

>+

1X.5

Objectives

Systems for Team-Based Functioning

High Performance Work Systems

Managing Empowerment and Accountability

Designing Roles and Systems for Flat, Networked Organizations
Developing Competencies for New Organizational Forms

ENTREPRENEURSHIP AND NEW VENTURES

The major emphasis of the course will be on creating a learning system through
which management students can acquaint themselves with the special challenges
of starting new ventures and introducing new product and service ideas. This will
involve working together to investigate, understand and internalize the process of
founding a startup. Bootstrap and guerilla tactics to gather resources - the technology,
team, finance and market - to give birth to entrepreneurial businesses will be

discussed.

The course

is designed primarily for those who at some point of their career want to

start their own ventures, or run their own family businesses. But it is equally useful
to those who plan to work in or with new ventures either as venture capitalists,
consultants to new firms or in new business development units of larger corporates.



Topics
1. The early career dilemmas of an entrepreneur
» The entrepreneuris role, task and personality
» A typology of entrepreneurs: Defining survival and success
» Entrepreneurship as a style of management
» The entrepreneurial venture and the entrepreneurial organization

2. Choosing a direction

» QOpportunity recognition and entry strategies: New product, Franchising,
Partial momentum, Sponsorship and Acquisition

»  The strategic window of opportunity : scanning , positioning and analysing
» Intellectual Property : Creation and protection

3. Opening the window: gaining commitment
» Gathering the resources you donit have
» The business plan as an entrepreneurial tool
» Financial Projections: how to do them the right way
» Debt, venture capital and other forms of financing
=+  Sources of external support
» Developing entrepreneurial marketing: Competencies, networks and
frameworks
4. Closing the window: sustaining competitiveness
» Maintaining competitive advantage
» The changing role of the entrepreneur : mid career dilemmas
» Harvesting Strategies versus Go for Growth

IX.6 INTERNATIONAL MANAGEMENT

Objectives

& Develop a proper empirically grounded perspective on the process of
international economic integration.

@ Provide an overview of the political economy of global integration that defines
the historical evolution of enactment and enforcement of regulations [at the
multilateral and national level] governing cross-border economic activity.

< Develop an understanding of the strategic issues [at the level of the business
firm] governing the operation and organization of international business.

@D



Questions addressed will include, for instance, the various modes of entry into
foreign markets and the costs and risks associated with each mode of entry,
the degree of autonomy that can/would be/are provided to the foreign
subsidiary vis-a-vis headquarters, problems of managing cultural diversity
across different nations where a multinational firm operates, and so on.

@ This course lays special emphasis on developing an understanding and
appreciation of problems of 'late industrialization' and the emergence of
successful global firms from developing economies A particularly the
experience of firms from South East Asian economies as well as those from
China.

@ To sensitize participants to the diversity of institutions and its impact on
businesses across different economic systems around the world.

Topics

1. States, Markets and Firms : The Analytics

2. Globalization Reexamined : Nature and extent of global integration at the end
of the 20th century

3. The process of 'late industrialization' in developing economies

4. Big Business and Multinationals : Patterns in historical evolution

5. Anti-dumping, WTO and the political economy of Multilateral trading system

6. Global Sourcing : Dynamics in global commodity chains

7. Modes of entry into foreign markets.

8. International Strategy and organization of international business.

9. Managing cross-cultural differences in multinational firms and HR Issues in
international business.

10. Strategic trade and industrial policy.

11. Late industrialization and globalization of firms from developing economies.

12. Growth of high-tech industries in developing economies.

13. Globalization of Chinese firms.

14. Competition from foreign firms and reaction of domestic enterprises in India

in 1990s.



IX.7 MANAGING PRIVATE-PUBLIC PARTNERSHIPS

Objectives

@ |llustrate the value of partnerships in sectors like infrastructure, health,
education, urban renewal and business development services.

@ List factors critical to successful cooperation, and a suggested approach to
planning, implementing, and operating successful public-private ventures.

& Discuss representative examples of public-private sector cooperation which have
worked, and of others that have failed, including the reasons why.

@ Recall the types of legal, regulatory, financial, procurement, contracting,
management, administrative and public policy issues, which must be taken
into account.

& Relate the relative strengths, weaknesses, advantages and disadvantages of
different forms of cooperation, as viewed from the perspectives of the user
community, a typical government agency and a typical private sector
organization.

@ Recognize and describe the various forms that public-private partnerships can
take.

< Explain the approach to HR planning, financing and public relations required to
ground successful PPP projects.

Topics

1. Rationale and options for PPP

»  Sector wise analysis of PPP leading to a methodology matrix to determine
which PPP option best fits a pilot project or sector. Discuss different types

of PPP options i service / management contracts, joint ventures,
divestiture, licensing, leases and concessions. Familiarize students with
the planning priorities of the government that create windows of
opportunity for the private sector.

2. Screening PPP Project Opportunities
» Pre feasibility Project Identification and Selection Process

» Cost comparator and value for money models to rank and select highest
quality projects and decide on go or no- go

» Project finance and risk allocation, Planning for PPPs
» Credit enhancement techniques for PPP Project financing

3. PPP Procurement Strategies
» Selecting the appropriate Procurement Method for PPPs



» Procurement and Tendering Regulations for PPPs in India

» HR systems of government and civil society : whom to speak to and how
in the bureaucracy

» PPP negotiations skills and techniques and risk mitigation strategies

4. Regulation, Monitoring and Compliance

» Key elements for an appropriate enabling and regulatory environment
for PPPs

» Simulation : Structuring and regulating a PPP contract

5. Institutionalizing PPP Processes within public systems and within the private
sector.

IX.8 MERGERS, ACQUISITION AND CORPORATE
RESTRUCTURING

Objectives
@ To deal with the most current subject in depth.

@ To inter-link the subject of finance with the major strategic decisions of a
proactive firm.

Topics

1. Various Forms of Business Alliances

2. Strategic Choice of Type of Business Alliance

3. Who should go for Merger and Acquisition and Take-over

4. Defining and Selecting Target

5. Pricing of Mergers (Pricing the Competitive Bid for Take-over)
6. Negotiation/Approach for Merger, Acquisition and Take-over
7. Contracting

8. Implementation of Merger and Acquisition

9. Managing Post-Merger Issues

10. Legalities Involved in Merger, Acquisition and Take-over

11. Ethical Issues of Merger and Take-over



12. Accounting for Mergers
13. Financing the Mergers and Take-overs
14. Corporate Restructuring

15. Divestment and Abandonment

IX.9 RESOURCE BASED STRATEGY

Objectives

@ Gain an understanding of the concepts, frameworks and checklists associated
with the resource-based approach to strategy

< Develop the skills to apply these to analyse resources, identify ways of
achieving competitive advantage and leveraging resources

Topics

1. The Resource Based Perspective
» Resources Based View of the Firm
» |ntegrating with Industrial Organisation Paradigm

2. Resources : Conceptual and Analytical Schema
»  Assets and Skills
» Tangible and Intangible Resources
»  Critical Resources, Target Resources, Resource Bundles
» Slack Resources
» Flexible and Rigid Resources

3. Resource Based Approach to Competitive Strategy
» |diosyncratic Resources and Business Level Competitive Advantage
» Capabilities and Competitive Advantage

4. Resource Based Approach to Corporate Strategy
» Slack Resources and their Deployment
» Leveraging Critical Resources
» Expansion and Diversification Strategies
» Managing the Multibusiness Firm

5. Review and Integration
» Effective Corporate Strategies and their Adaptation
» Corporate Governance



IX.10 STRATEGIC HUMAN RESOURCE
MANAGEMENT

Objectives

The objective of the course is to develop the perspective of strategic human
resource management. Specifically the course has the following objectives:

< Distinguish the strategic approach to human resources from the traditional
functional approach.

< Understand the relationship of HR strategy with overall corporate strategy.
@ Understand the strategic role of specific HR systems.

@ Appreciate SHRM in the context of changing forms of organisation.

Topics

1. Business Strategy and Organizational Capability

2. Global Environment of HR: Change and Diversity

3. SHRM: Aligning HR with Corporate Strategy

4. SHRM: Universalistic, Contingency and Configurational Approaches

5. Strategic HR Planning Acquisition and Development

6. Corporate Strategy and Career Systems

7. Managing Employee Relations: Unions and Strategic Collective Barganing
8. Change, Restructuring and SHRM

9. Corporate Ethics, Values and SHRM

10. Competencies of HR professional in a SHRM scenario

11. Evaluating the Effectiveness of SHRM



IX.11 STRATEGIC MARKETING

Objectives

Being a capstone course of the Marketing Module, some of the key objectives of this
course are :

< To help students sharpen their analytical abilities in integrating strategic
marketing decision in a comprehensive manner.

< To become familiar with the concepts and framework in marketing strategy,
strategic market planning, competition analysis and in creating competitive
advantage.

@ To relate marketing in the context of the whole organization with special
emphasis on strategic management.

Topics

1. Many Facets of Strategic Marketing

2. Strategic Marketing : Over all view

3. Product and Service Strategy and Management
4. Re Aligning Marketing Resources

5. Competitive Strategy

6. Trun Around Strategy

7. Opportunity Analysis & Market Targeting

8. Distribution Strategy

9. Innovative Strategies

10. Product & Service Strategy & Management
11. Growth Strategies

12. Strategic CRM : Facets and Pay offs



IX.12 STRATEGIES FOR MANAGING INTERNATIONAL
HEALTH SYSTEMS

Objectives

This course surveys the major components of and organizational interrelationships
in health care systems. Students examine a range of topics including: the
organization of health care, personnel issues, delivery systems, health care policy,
and payment mechanisms. This course introduces students to the public policy and
business practice issues associated with access, cost, and quality. Finally, the class
compares how several countries are answering these complex questions. The class
draws upon a range of articles and case studies.

@ To understand the growth and evolution of Global healthcare system.

& To review the major settings of healthcare and how and why these settings are
changing.

@ To study the underlying reasons for and consequences of the emergence of
managed care.

@ To critically examine some of the leading ethical dimensions in the market for
healthcare.

@ To compare the healthcare system in developed world with the systems in other
industrialized countries.

Topics

Financing of Healthcare

The Healthcare workforce

Hospitals

Ambulatory care

Long term care

Drugs

Managed care

The role of government
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Quality of care
10. Access

11. Comparative healthcare systems



IX.13 STRATEGIES OF CO-OPERATION

Objectives

Strategies of co-operation can take several organizational forms A strategic

alliances between two or more partners, or equity joint ventures A all of which,
in terms of its legal and contractual nature, are hybrid forms of economic
organization; falling somewhere between arms-length market based interaction
and hierarchical interaction within boundaries of a firm. Co-operative strategies,
however, are not meant to supplant competitive strategies pursued by firms fi they
are rather ways to strengthen its competitive position.

The focus of the course, will be on developing an appreciation of the various
contexts under which firms pursue strategies of co-operation fi through strategic
alliances, joint ventures or through participation in networks.

The course would also seek to sensitize participants to the complexities A
about administrative structures, control systems etc. i in managing alliances
with partners and effectively dealing with it.

Topics

1. Nature of the firm : markets and hierarchies in economic organization

2. Hybrid forms of economic organization : Alliances, Networks and Equity
Joint Ventures

3. Typology of strategic alliances

4. Significance of networks as a mode of economic organization
» Knowledge networks and technological innovation in networks
»  Networks to set industry standards

» Social Networks : Competitive significance of relations beyond firm
boundaries

5. Alliance between competitors
» Pre-competitive alliances
» Market sharing alliances

6. Organizational learning through alliances
»  Structures and systems for effective learning for partners in alliances

7. Managing the process of alliance formation : Partner selection and
negotiation

8. Contracts and trust in managing partner conflict in alliances

9. Evolution and termination of alliance relationships



IX.14 TECHNOLOGY MANAGEMENT

Objectives

&

The course focuses on different matters of importance related to
Technology Management. It discusses various aspects of technological
innovation and subsequent diffusion. It also analyses the Technology
Management scenario in India.

Topics
1. Evolution of Technology; Effects of New Technology
2. Technology Innovation
» Invention-Innovation-Diffusion
» Revolutionary and Evolutionary Innovation
»+ Product and Process Innovation
3. Strategic Implications of Technology
» Technology - Strategy Alliance
» Convergent and Divergent Cycle
» The Balanced Approach
4. Technology Assessment
» Technology Choice
» Technological Leadership and Followership
»  Technology Acquisition
5. Technological Forecasting
» Exploratory : Intuitive, Extrapolation, Growth Curves, Technology
Monitoring
» Normative: Relevance Tree, Morphological Analysis, Mission Flow
Diagram
6. Diffusion of Technology
» Rate of Diffusion; Innovation Time and Innovation Cost
»  Speed of Diffusion
7. Technology Indicators
»  Various Indicators
8. Organizational Implications of Technology

» Relationship between Technical Structure and Organizational
Infrastructure

» Flexible Manufacturing Management System (FMMS)



10.

11.

12.
13.

Financial Aspects in Technology Management
» Improving Traditional Cost Management System
» Barriers to the Evaluation of New Technology

Social Issues in Technology Management
» Technological Change and Industrial Relations
» Technology Assessment and Environmental Impact Analysis

Human Aspects in Technology Management
» Integration of People and Technology
» Organizational and Psychological Factors
» Qrganizational Outcome

Technology Transfer

Technology Management Scenario in India
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